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RM Billing Secondary Training Program 

Day 1 

Time Contents 

8.45am Coffee 

9.00am Welcome 
Housekeeping 
Introductions and Registration 

9.15am Introduction to the RM Billing module 
Implementation of RM Billing at your school 
Getting started with RM Billing for the first time 
Overview of RM Billing 
Creating Billing Codes 
Setting Student Billing Categories 
Subjects and Costs 

10.30am Morning Tea 

10.50am Creating Charges and Contributions Sheets for the current year 
Alternative Method of Billing for Timetabled Schools Years 7-10 
Producing Charges and Contributions Sheets 
Subject Changes 
Creating Billing Items for students 
Billing Students 

12.30pm Lunch 

1.00pm Government Subsidies 
Individual Billing 

1:30pm Discounts 
Charges and Contributions by Department Reports 
Receipting 
Statements 
External Customers 

3.00 Finish 

Day 2 

Time Contents 

8.45am Coffee 

9.00am Review Activity 

10.30am Morning Tea 

10.50am RM Billing & RM Finance Interface 
Manual input of receipts to RM Finance 
Follow up of unpaid debts 
Enter Notes for students 
Turn on Export function 
Adjusting and Reversing Billing Items 

12.30pm Lunch 

1.00pm Reverse and Refund Receipts 
RM Billing and Administration Module  
Write-off/Cancel Billing Items 
Unallocated Credit 
Reallocation Report 
End of Month Procedures 

3.00pm Finish 
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Training Outcomes 
 
At the end of the RM Billing Secondary Training Program participants should be able to: 
 

 Understand the process of the implementation of RM Billing at their school 

 Produce Charges and Contributions Sheets for students 

 Create Subject Billing Items 

 Create Billing Item Batches 

 Bill students in bulk 

 Bill students individually 

 Create Secondary Financial Assistance Applications 

 Export Secondary Financial Assistance Applications 

 Import Government Subsidy Receipts 

 Apply discounts  

 Create receipts batches 

 Apply receipts 

 Create records for external customers 

 Enter receipts manually into RM Finance 

 Produce Statements and Reminders of Unpaid Billing Items  

 Enter Notes for students 

 Understand the process of Exporting to RM Finance 

 Create Corrections and Refunds batches 

 Correct errors and make adjustments to transactions 

 Refunds through EFT, System and Manual cheques 

 Write-off/Cancel debt  

 Export Re-allocations to RM Finance 
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1 Introduction to the RM Billing Module 
 
RM Billing is a module available within Integris.  When the RM Billing module is added, a new 
sidebar called RM Billing appears. 
 
This module allows both students and external customers (companies and/or individuals external 
to the school environment) to be billed for any type of cost.  Students can be billed for subject 
related costs, charges and voluntary contributions, other optional costs, voluntary approved 
requests, camps and excursions etc. Customers can be billed for items such as hire of the school 
facilities which could be such things as a gymnasiums, halls, swimming pools etc. 
 
Student details and those of their related contacts (e.g. Parent/Guardian 1, Parent/Guardian 2 
etc.), should be accurate within the Administration module before adding the RM Billing module.  
Each student should have one contact nominated as the person who will be responsible for paying 
their costs.  Correspondence generated from RM Billing - such as Charges and Contributions 
Sheets and Statements - will be addressed to the first contact marked for Fees Billing for each 
student in the Administration module. RM Billing will draw on student and contact data held in the 
Administration module. 
 
The RM Billing module can be used in conjunction with the Timetabling module (optional).  Student 
subject preferences from Timetabling are available in RM Billing.  Costs for each subject can be 
entered in RM Billing and students can be billed according to the subjects they have chosen to 
study.  The bulk billing facility enables students to be billed en masse for any other types of costs.  
 
RM Billing supports several methods of receipting (including bulk receipting) and provides a suite 
of useful reports. 
 
RM Billing can also be linked to RM Finance. A set of Billing Codes created in RM Billing provide 
the link to the budget and analysis codes used by the school in RM Finance. Receipts entered in 
RM Billing can be automatically exported to RM Finance against the correct budget and analysis 
codes.  
 
The following diagram illustrates how RM Billing interacts with other Integris modules. 
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1.1 Logging on to the System 

Activity: Logging On 
 

 Double click on the RM Billing Secondary icon on your desktop 
 

 
 

 Type ADMIN into the User Name field 

 Press the <Tab> key 

 Type KEYS into the Password field 
 

 
 

 Click on Login, or press <Enter> 
 

Note:  In schools, each user has their own user name and password, which enables access 
to particular sections of the software as determined by the school administration. 

It is strongly recommended that you change your password regularly. 
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1.2 The File Menu 

The file menu may be accessed by clicking on File in the top left of your screen. 
 

 
 

 Password enables the user to change his or her password.  For security purposes, it is 
recommended that this is done regularly. 

 Change User should be used to ensure that each person accessing Integris does so under 
their own user name and with their personal levels of access. 

 Lock Terminal may be used if the user needs to leave his or her computer temporarily, does 
not want to log off and does not want to allow access to anyone else.  Unlocking the terminal 
requires the user to enter his or her password again. 

 Report Destination allows the user to choose where to send any report created in Integris.  
The options are displayed below. 

 
 

Activity: The File Menu 

Top Toolbar > File 

 View each of the following items in the File menu 

 Password 

 Change User 

 Lock Terminal 

 Report Destination 
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2 Accessing Help 

Activity: The Help Function 

Top Toolbar > Help > Help Contents and Index 

 Click Help in the top toolbar 

 Select Help Contents and Index 
 

 
 

 Highlight Integris RM Billing Help 

 Click Help 

 View the manual  

 Close the manual and Help 
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2.1 Implementation of RM Billing at Your School 

As with any new Integris module the RM Billing module must be implemented at your school before 
it can be used. 
 
There is a standard process for the implementation of this new module which will be completed by 
your project officer. In this training course we will discuss the process to be used at your school as 
closely as possible, to enable you to assist your project officer in the process. 
 

2.2  Preparation of Administration Manager Data 

Before implementing the RM Billing module it is important that the data held in the Administration 
Manager module is as accurate as possible and is set up for use with RM Billing.   
This is because the RM Billing module accesses data held in the Administration module.  In 
particular, student names and the details of their associated contacts (e.g. parents/guardians) are 
used by RM Billing. 
 

2.2.1 Ensure Administration Manager Data is Accurate 

You should ensure that the student names and addresses and the names and addresses of their 
contacts are up to date. If you have been advised of any name or address changes then these 
should be updated before the module is added. 
 
Refer to the document ‘Student Details – SIS Data Entry Procedures’ available from 
http://www.det.wa.edu.au/education/sis/dataentryprocedures.htm 
 

Activity: Viewing the Fees Biller 
 
Michael Brogan’s address details and his Parent/Guardian information is incomplete. Mrs Alison 
Brogan is the Fees Biller. 

General > Student Details  

 Type BRO,M in the Search field  

 Press <Enter> to display Michael Brogan’s student details 
 
The Fees Biller can be viewed from the Student Details Summary screen. 
 

 
 

 Mrs Brogan’s details have not been entered 
 

  

http://www.det.wa.edu.au/education/sis/dataentryprocedures.htm
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 Click on the Edit Pencil  

 Choose Family Group tab 

 Enter the details as shown below for Mrs Brogan 
 

 
 

 Click on the Edit Pencil in the Address box  

 Select Linked to Student Address 
 

 
 

 Click OK 

 Select Parent/Guaradian 2 tab 

 Untick Family Mail Marker 

 Enter his Mobile number  

 Delete the Salutation 
 

 
 

 Click OK 
 

 
 

 View the details for Mrs Brogan and that she is now the Fees Biller 
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2.2.2 Set the Fees Billing Marker 

Each student to be billed must have one contact nominated as their ‘Fees Biller’. This should be 
the person who is responsible for paying any costs associated with the student (i.e. the contact 
who has been marked as the Fees Billing Marker on the Admissions Form). 
 
RM Billing will only use one contact for the fees biller. It is not possible to have multiple fees billing 
contacts in RM Billing (see important note below). 
 
It is therefore recommended that only one contact be ticked for Fees Billing in the Administration 
module.  

IMPORTANT: 

If more than one contact is selected as the Fees Biller in the 
Administration module, RM Billing will search the contact list and use 
the first Fees Billing marker ticked as the contact responsible for the 

student’s costs.  The software will search the contacts in order of 
Parent Guardian 1, followed by Parent Guardian 2 followed by any other 

contacts in the order listed. 

It is likely that your school will have already set the fees billing marker from the information listed 
on the Admissions form.   
 
However, if you do not have the Fees Billing Marker already set for your students you can use 
speed edit to help with viewing and editing this field.  
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Activity: View the Fees Biller in Speed Edit 

Admin > Speed Edit 

 Click on the dropdown box called ‘Area’ and select   
 

 Click on the student search binoculars   

 Click Find 

 Click Select 

 Click Yes  
 

 
 
All the students on the current roll will display showing where Parent/Guardian 1 is marked as 
the Fees Biller. In the Training database this is ALL students. 
 

 Click on the Area drop down box and change to view Parent/Guardian 2 Fees Billing 
 

 
 
The list will update to show students who have Parent/Guardian 2 ticked as Fees Biller. 
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Note: Where more than one Contact is nominated as the Fees Biller, the software will 
default to make the highest contact the Fees Biller. 
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2.3 Fees Biller for Other Rolls 

2.3.1 Students on the Admissions Roll 

Students on the Admissions Roll can be billed in the same manner as students on the current roll. 
A contact must be nominated as the fees biller before the students can be seen in RM Billing. 

2.3.2 Students on the External Roll 

If your school uses an external roll then these students can be billed also. Again a contact must be 
nominated as the fees biller before the students can be accessed in RM Billing. 

2.3.3 Students on the Former Roll 

In most cases it will probably not be necessary to bill students on the former roll. However, it is 
possible to do so by marking a fees biller for them (as for students on any roll). If students on the 
current roll have been billed in RM Billing and they then move to the former roll, their billing records 
and details will be retained in RM Billing and can be accessed and dealt with as necessary. 
 

Activity: Billing students on the Admissions Roll 
 
Set the fees billing marker to Parent Guardian 1 for all students on the Admissions roll. 

Admin > Speed Edit 

 Click on the dropdown box called ‘Area’ and select   

 Click on the student search binoculars   

 Choose the roll status of Admissions   

 Click on Find, Select and Yes to select ALL students 
 

 Click  to highlight all the students 
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 Place a tick in the New Value box at the bottom of the window  

 Click on the blue tick to make the modifications   

 The letter M will appear in the ‘Status’ column 

 Click on Save to save the modifications 
 

 
 

 Click on Yes 

 Click on  Close 
 

 

IMPORTANT     

If the Fees Biller changes for a student, the existing information can be 
edited in the Administration module to reflect the new Fees Biller and 

RM Billing will automatically be updated with the new details.                                                                                           
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Setting the Fees Billing marker for PG2 or Other Contacts 

If you have any students where the Fees Billing marker needs to be set for Parent/Guardian 2 or 
for another contact you need to do the following: 
 

 Ensure that the fees billing marker for all previous contacts is not ticked 

 Tick the fees billing marker for the correct contact 
 

Activity: Setting the fees biller to PG2 or other contacts 
 
Ben Anderson has two Fees Billers ticked, (P/G 1 and P/G 2) so the Fees Biller is defaulting to 
P/G 1. This needs to be updated to Ben’s father Alan Anderson whio is currently P/G 2. 

General > Student Details 

 Type AND,B in the Search field  

 Press <Enter> to display Ben Anderson’s student details 
 

 
 

 Click on the Edit Pencil  

 Select the Family Group tab and in the Parent/Guardian 1 tab 

 Remove the tick from the Fees Billing checkbox for Mrs Linda Anderson 
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 Click OK to Save 
 
The Fees Biller information is updated. 
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2.4 Preparing RM Finance (Discussion Only) 

 Analysis Codes N3100I and N3100E Other Suspense Accounts must be created in RM 
Finance as these are used for recording Unallocated Credit. 

RM Finance > Records > Income/Expenditure Analysis 

 
 

 
 

 Budget Code N3199 Billing Suspense Account must be created in RM Finance.  This account 
is used to hold Unallocated Credit recorded in RM Billing. 

 

RM Finance > Records > Budget Accounts 

 
 
 

2.5 Adding the RM Billing Module 

The implementation of the RM Billing Module will be undertaken by your Finance Consultant 
(Schools) and must not be added by any school personnel.  Your Finance Consultant (Schools) will 
manage all steps in the preparation for and installing RM Billing, including the recording of any 
opening balances. 

IMPORTANT 

Your Finance Consultant (Schools) will manage all steps in the 
preparation and installation of the RM Billing Module. 
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Activity: Logging onto RM Finance 
 
All RM Billing Users must log onto RM Finance before any processing can be undertaken. 

RM Billing > Parameters 

 Select User Name Manager Corporate Services 

 Enter password Keys 
 

 
 

 Click on   
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2.6 Getting Started 

Once the RM Billing module has been implemented, your Project Officer will assist with the setting 
up of the RM Billing Parameters and Log in procedures. 

2.6.1 Setting the General Parameters 

The General tab in the Billing Parameters window must be set in accordance with the following 
instructions: 
 

General Tab  

Monetary Value 
Warning Limit   

Already set to $1000. Leave this as it is. 
(When processing, if an entered amount exceeds the value defined 
in this box a warning message will be displayed asking for 
confirmation that the entered amount is correct.) 

Date Warning Limit Already set to 30 days. Leave this as it is. 
(When processing, if the date that is entered against a transaction 
is older than the number of days specified in the Date Warning 
Limit box a message will be displayed asking for confirmation that 
the date entered is correct.) 

Schools Biller Code 1 If you have elected to display the BPAY logo, enter your school’s 
BPAY Biller Code into this field. 

Schools Biller Code 2 This field should be left blank.  It is a provision for possible future 
functionality 

Last Year End Schools will be advised by their Finance Consultant (Schools) 

Accounting System Already set to RM Finance 

ABN Enter your school’s ABN into this field. (e.g. 11 222 333 444). 

Options Automatically show student balances.  This box is ticked by default 
and displays current student balances when the student window 
opens.  If the option is ‘unticked’, the user has the option of 
showing the balances when the ‘Show Balance’ tab is selected in 
the Student window 

RM Finance Datafile The location and name of the RM Finance datafile is 
k:\RMDB\finance.df1.  You only need to change this if your datafile 
is located elsewhere (for example if you share a server with an 
ESC). For the training course only this is set to 
C:\keys\RMDB\Finance_Demo.df1.   

Enable Export To RM 
Finance 

When this option is not selected, schools will be unable to export 
transactions automatically into RM Finance. When schools are 
ready to begin exporting transactions into RM Finance, contact the 
Customer Service Centre (CSC) at the Department of Education 
for approval.  Note that once this option is ticked and saved it 
cannot be ‘unticked’. 

RM Billing Archive File 
Path 

At school this will be set to K:\keys\RMDB\OLDDATA\Billing 
Archive. This folder will hold reports created from a Utility to Purge 
Former Roll Students. The Utility purges all transactions from 
Former Roll students with a zero balance and a leave date of at 
least one year prior to the last year end date, along with those 
transactions from students who have been Deleted from Admin.  

Secondary Financial 
Assistance 

This path is Optional, however schools may set a default path for 
the use of saving files created by the Secondary Financial 
Assistance export. The pathway can be changed if required, by 
clicking on the Change Parameters button and then choosing the 
‘Browse’ button to the right of the Archive Folder path. Suggested 
pathway is K:\RMDB\SECONDARY ASSISTANCE 
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IMPORTANT  

Please note that the Billing Archive folder needs to be created with a 
space in between the words ‘Billing’ and ‘Archive’ as shown in the 

screen shot above. 

 The specification lists this folder name without a space. 
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2.6.2 Setting the Charges and Contributions Parameters 

If you are going to use RM Billing to produce a Charges and Contributions Sheet you will also need 
to set up the Parameters for the Charges and Contributions tab. If you are not producing Charges 
and Contributions Sheets then this section can be bypassed. 
 

Charges and Contributions Tab  

Show School Address   Tick this box if you would like the school 
name and address to be printed at the top 
of the Charges and Contributions Sheet. If 
un ticked the school name and address 
will not appear so that school letterhead 
can be used. 

Show School Logo on right hand side Tick this box if you would like the school 
logo to appear on the right hand side of 
the header. 

Show Department Logo on left hand side Tick this box if you require the 
Department’s logo to appear on the left 
hand side of the header, however schools 
must not use the Department’s logo on 
any items unless they have an 
international element to their operations. 

Narrow Logo/Wide Logo If you have elected to show the 
Department’s Logo then choose the 
correct radio button to indicate whether 
the narrow or wide version of the logo is 
going to be used. 

Department Logo Path If you have elected to show the 
Department’s Logo then click on the spy 
glass to the right of this field and navigate 
to the location where the logo is stored. 

Show BPAY Logo Tick this box if you would like the BPAY 
logo to be displayed on the Charges and 
Contributions Sheet. 

Show Remittance Advice Tick this box if you would like a remittance 
advice slip to be printed at the end of each 
Charges and Contributions report.  
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2.6.3 Statement Parameters 

 

Statements Tab  

Default Statement Message Enter a message which the school would like to 
appear on the bottom of the student statements,  
eg:  ‘Please contact the school office on  
9229 7777 if you have any queries regarding this 
account’. 
Note that the message can be edited/altered at 
the time of printing if required. 
 

Show School Address Tick this box for training.   
 
If this box is ticked, the school’s name, address, 
phone number and ABN will be included in the 
top left hand corner of the statement. 
If this option is not ticked, then this space is left 
blank for the school letterhead. 
 

Show School Logo on the right hand side This will allow the school logo to be displayed on 
statements in the top right hand side of the report. 
 

Show BPAY Logo Tick this box if you would like the BPAY logo to 
be displayed on the Statement. 
 

Show Remittance Advice Tick this box if you would like a remittance advice 
slip to be printed at the end of each Statement. 
 

Show CC Number Tick this box if you would like the student’s 
Curriculum Council number to be displayed on 
the Statement. This setting is applicable to the 
Student Statement only (not the Customer 
Statement). 
 
 

Default Reminder Notice Default Reminder Notices can be sent out 
reminding Fees Billers of Unpaid Billing Items. 
Enter a message which the school would like to 
appear on the bottom of the reminder notice,  E.g.  
‘Please contact the school office on 9229 7777 if 
you have any queries regarding this notice’. 
Note that the message can be edited/altered at 
the time of printing if required. 
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2.6.4 Invoice Parameters 

 

Invoice Tab  

Show BPAY Logo If ticked, this will display the BPAY Logo and 
payment details (Biller Code and Reference) 
on the statement. 
 

Show Remittance Advice When ticked, a remittance advice will be 
printed on the bottom of the invoice displaying 
the school name, address, school phone 
number. 
 
Note:  There is no option to turn on/off school 
logo.  If set up in General > Control > 
Preferences > Reports, it will appear on 
invoices by default. 
 

Default Invoice Message The Default Invoice Message can be set up 
with the School’s Bank Account details for 
Billing payments.  
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2.6.5 Enter Charges and Contributions Parameters 

Activity:  Enter Charges and Contributions Parameters 
 
RM Billing > Billing Parameters > Charges and Contributions Tab 
 

 Click  

 Click on the Charges and Contributions tab 

 Enter the Parameters as shown below 
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2.6.7 Enter Statement Parameters 

 

Activity: Enter Statement Parameters 

RM Billing > Billing Parameters > Statement Tab 

 Click on the Statement Tab 

 Enter Statement Parameters as shown below 
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2.6.8 Enter Invoice Parameters 

 

Activity:  Enter Invoice Parameters 
 
RM Billing > Billing Parameters > Invoice Tab 
 

 Tick ‘Show BPAY logo’ 
 

 Tick ‘Show Remittance Advice’ 
 

 Enter an ‘Invoice message’ with the School’s Bank details for Billing payments 
 

 
 

Note:  The Invoice parameter settings will apply to both student and customer invoices 

 Click  to save the Parameter settings   

 Close Parameters and Close the Billing Parameters window 
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3 Brief Overview of RM Billing 

3.1 Students 

When the Student window opens, all students on the current roll are displayed along with their 
current year group and current form. 
 

 
 

3.1.1 Student Icons 

The following icons are available on the Student List screen. 
 

 
Standard Student Find Tool 

 
Load Current Students – Displays all students on the current roll 

 
Open Details – Opens the drill down facility for the selected student 

 
Print – Prints all students displayed in the list view 

 
Print Selected – Prints all selected (highlighted) students in the list view 

 
Hide Selected – Hides all selected students 

 
Hide Unselected – Hides all unselected students 

 
Show/Hide Deleted Students – Displays students who have been deleted from the 
Administration module but still have a record in RM Billing 

 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 38 of 322 

© 2019 Civica Pty Ltd 

 

 

3.1.2 Opening the Students Window 

The very first time the Students window is opened, a record for each student on the current roll will 
be created in RM Billing. Therefore, this process may take a few minutes when run for the first 
time.  
 

3.1.3 Using the Student Window Icons 

Activity: Using the Student Window Icons 

RM Billing > Students 

 Click Find Student  

 Select Year Group 9 to display only the Year 9 students 

 Find > Select > Yes 
 

 Click Load Current Students  to display all students who are on the current roll 

 Highlight any student and select Open Details  

 Click Return to View  
 

 Click Print List  

 Close the Student Summary Report 

 Hold <Ctrl> and select 5 students from the list 

 Click Print Selected  

 Close the Student Summary – Selected Items Report 
 

 Click Hide Selected  to hide those selected students 

 Hold <Ctrl> and select 5 students from the list 

 Click Hide Unselected  to only view those selected students 

 Click Load Current Students  to display all students who are on the current roll 

 Click on the Notes Header twice to bring all students with Notes attached to their record to 
the top of the window 

 Highlight the students with notes 
 

 
 

 Click For Selected and Print Notes 

 Click OK to ignore the Date Range 

 View and close the Notes Report 
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3.1.4 Quick Search on Student Surname 

A quick search on student surname is available on this window. For example, if you click on the 
first student in the list and then type the letter ‘B’ the cursor will move to the first student whose 
surname begins with ‘B’. If you type the entire surname (e.g. BORN), the first student in the list with 
that surname will be highlighted. 
 
 

3.1.5 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a student name. 
Note that all transactions will be attached to the student’s record. The name of the fees biller is 
also attached to this record. 
 
 

3.1.6 Red Fields 

 
 
The red fields at the top of the screen are scroll fields and search fields.   

 Left click to view the next student.   

 Shift and left click to view the previous student.   

 Right click to enter the name of a new student to view.  

 It is recommended that users work with smaller groups of students and this method is used to 
navigate between students. 

Note: It is quicker to search for students from within the drill down section rather than 
returning to the front screen. Either the red fields or the binoculars can be used. 

3.1.7 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen.   
Selecting return to view will recalculate student balances.    
 

Activity: Searching for Students 

RM Billing > Students 

 Type the Surname Born 

 Double click Corrina Born 

 View the tabs available in the student window 
 

 Click on the red Surname field  to scroll through the student names 

 Right click in the Surname filed and type BROWN<enter>. The first student with that 
surname is displayed 

 Close the Student details window 
 

 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 40 of 322 

© 2019 Civica Pty Ltd 

 

3.2 Customers 

This section is used to bill customers who are external to the school (i.e. not 
parents/guardians/students). For example the local theatre group who wish to hire the school hall 
for their rehearsals. 
 
Customer records can be created at any time by the user.  
 
The functionality available in the Customers section is very similar to the functionality available in 
the Students section. 
 

 

3.2.1 Customer Icons 

The following icons are available in the Customers section. 
 

 
Load All – Displays all customers in the list view 

 
Open Details – Opens the drill down facility for the selected customer 

 
Print – Prints all customers displayed in the list view 

 
Print Selected – Prints all selected (highlighted) customers in the list view 

 
Hide Selected – Hides all selected customers 

 
Hide Unselected – Hides all unselected customers 

 
Add Customer – Allows a customer record to be added 

 
Edit Customer – Allows a customer record to be edited (restricted editing only if 
there are transactions against the customer) 
 

 
Delete Customer - Allows a customer record to be deleted (only if there are no 
transactions against the customer) 
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3.2.2 Quick Search on Customer Name 

A quick search on Customer Name is available on this window. For example, if you click on the first 
Customer and then type the letter ‘B’ the cursor will move to the first Customer whose name begins 
with ‘B’. If you type the entire Customer Name then that Customer Name will be highlighted.   
  

3.2.3 Drill Down Facility 

Drill down functionality is instigated by double-clicking or pressing <enter> on a Customer Name. 
 

3.2.4 Red Field 

The red field at the top of the screen is a scroll field and a search field (see Students section). 
 

3.2.5 Return to View 

Use the blue circular arrow   to return from the drill down display to the front list screen. 
 

3.3 Billing Items 

This section is used to create Billing Item batches. These batches will hold the billing item 
transactions once the students have been billed. The standard icons which have already been 
discussed are available on this window. 
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3.4 Receipts 

The Receipts section is used to create Receipts batches. These batches will hold the receipts 
entered into RM Billing. The standard icons which have already been discussed are also available 
on this window. 
 

 
 

3.5 Reports 

A variety of standard reports are available from this section as illustrated below. These will be 
covered as we progress through the training course. 
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3.6 Parameters 

Parameters can be set to customise the RM Billing module for use in your school. More detail will 
be provided on the relevant parameters during the course of this training. 
 
 

 
 
 

3.7 Utilities 

The Utilities section provides a set of standard routines/processes that need to be run at certain 
times within the RM Billing module. Again, the relevant processes will be covered as we progress 
though the training. 
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4 Using RM Billing – Other Required Settings 
 
Billing Codes provide a link between RM Finance and RM Billing. 
 
In RM Billing the Billing Code represents a general type of item for which a student can be billed.  
For example, a billing code would be created for Voluntary Contributions – Years 7 to 10. The 
billing code is linked to a specific analysis code and budget code within RM Finance which, for this 
example, would relate to the Voluntary Contributions for years 7 to 10.  
 
Billing Codes must also be linked to a billing category. The billing categories are the standard 
education categories – Voluntary Contributions, Charges, Other Optional Costs, Voluntary 
Approved Requests, Residential Boarding Fees, Adult Student Fees and Temporary Visa 
Overseas Students. An additional category of ‘Not Applicable’ is also available.  
 

4.1 System-Defined Billing Codes 

There are two system created billing codes NA and SUS. 
 
NA- This Billing Code can only be used if directed 
 
SUS-This Billing Code relates to the Billing Suspense Account N3199 in RM Finance.  It is used to 
receipt or refund any amounts held as Unallocated Credit.  That is amounts that have not been 
allocated against any Billing Items. 
 

4.2 User-defined Billing Codes 

It will be necessary to create some additional billing codes to be used at your school. These Billing 
Codes will represent the items/activities for which your students are commonly billed. 
For example, Voluntary Contributions Yrs 7-10, Charges Year 11, School Camps, Excursions, 
School Magazine etc. Each Billing Code must be attached to the correct billing category (as 
mentioned earlier) to ensure that the types of costs are correctly classified. 
 

4.2.1 Naming of Billing Codes 

There is a standard naming convention which should be followed when you are creating the billing 
codes for your school.  
 
Each Billing Code should begin with a standard 3 letter code followed by a two digit number. Refer 
to the table below for details. 
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Standard Naming Convention for Billing Codes 

Code Begins with For Category Code Used For (examples) 

VOL Voluntary Contributions Secondary Subject Voluntary 
Contributions 
Primary Voluntary Contributions 

CHG Charges Subject Charges 
School Camps 
School Excursions 
Hire of Facilities 

OOC Other Optional Costs School Magazine 
Yearbook 

VAR Voluntary Approved Requests P&C Contributions 
Chaplain 

NA Not Applicable Only use if directed 

REF Not Applicable Refunds 

TVS Temporary Visa Overseas 
Students 

Temporary Visa Student Costs 

ADU Adult Student Costs Adult Student Costs 

RBF Residential Boarding Costs Residential Boarding Costs 

 

Note:  Budget Codes and Analysis codes must be created in RM Finance before they are 
available to be used with RM Billing 

 

Note:  The Billing Codes and the Accounts used in the training material 
are examples only.  Users should refer to the current Chart of Accounts 

and the Summary of Changes for use in your school.  If you require 
assistance, please contact your Senior Finance Consultant 
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4.2.2 Creating a Billing Code 

To Add a new Billing Code, the following general rules apply: 
 

 Determine which category the Billing Code fits into 

 Use the appropriate first three letters given in the table above 

 Add a two digit number to the end of the code (no spaces) eg. VOL01 

 Give the code a description 

 Assign an Analysis Code to the billing code 

 Assign a Budget Code to the billing code 

 Assign a Billing Category to the billing code 
 

Activity: Add User-Defined Billing Codes 

RM Billing > Parameters > Billing Codes 

 Click Add Item  
 

 Type the Billing Code CHG02 <Tab>  
 

 Type the description Excursions and Activities <Tab> 
 

 Type the Analysis Code C1180 (or press <Tab> for a look-up list) <Tab> 
 

 Enter the Budget Code C1181 (or press <Tab> for a look-up list) <Tab> 
 

 Select the category Charges from the drop down list 
 

 Click OK to save 
 

 Using the above instructions add the billing codes listed below: 
 

Code Description Analysis 
Code 

Budget 
Code 

Category 

CHG03 School Camps C1180 C1182 Charges 

OOC01 Other Optional Costs C1200 C1201 Other Optional Costs 

VAR01 Voluntary Approved 
Requests 

C1500 C1501 Voluntary Approved 
Requests 

HIR01 Hire of Facilities C1700 C1705 Charges 
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4.2.3 Editing a Billing Code 

To edit a Billing Code: 
 

 RM Billing > Parameters > Billing Codes 

 Highlight the appropriate code 

 Click on the edit pencil (yellow pencil) 

 Update the required details 

 Click on OK to save  

Note: Once a Billing Code has been used in a transaction only the description can be 
edited. 

4.2.4 Deleting a Billing Code 

To delete a Billing Code: 
 

 RM Billing > Parameters > Billing Codes 

 Highlight the appropriate code 

 Click on the delete button (rubbish bin) 

 Answer ‘yes’ to the message 

Note: Once a Billing Code has been used in a transaction it cannot be deleted. 

4.2.5 Printing a list of Billing Codes 

To print a list of Billing Codes: 
 

 RM Billing > Parameters > Billing Codes 

 Click on the Print button 
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4.2.6 Refund Billing Codes 

At times it may be necessary to issue a refund via RM Billing. Refund transactions need to relate to 
a ‘D’ account (expenditure) in RM Finance. Therefore special refund type codes need to be created 
in RM Billing which link to the refund analysis and budget codes in RM Finance. 
 

Activity: Add a Refund Billing Code 

RM Billing > Parameters > Billing Codes 

 Click Add Item  

 Tick the Refund checkbox  
 

 Type the Billing Code REF03 <Tab>  
 

 Type the description Refunds – Facilities Hire <Tab> 
 

 Type the Analysis Code D4800 (or press <Tab> for a look-up list) <Tab> 
 

 Enter the Budget Code D4808 (or press <Tab> for a look-up list) <Tab> 
 

 Leave the category Not Applicable  

 Click OK to save 
 
Check to ensure there are no errors in the Billing, Analysis, Budget Codes or Descriptions. 
 

 
 

 Click  and select the screen and OK 

 Close the Billing Codes window 

 Close the Billing Parameters window 
 

 

Notes: ‘D’ accounts will only be available for selection once the refund checkbox has been 
ticked. Refunds of Unallocated Credit are processed against system code of SUS. 
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4.3 Setting the Student Billing Category 

Students within RM Billing need to be classified into their student billing category for the current 
billing year. 
 
The available student Billing Categories are: 
 

 Kindergarten 

 Pre-Primary 

 Primary 

 Secondary (Vol, Chg) 

 Secondary (Chg) 

 Adult 

 Temporary Visa 

 Full Fee Paying 
 
Billing categories must be assigned to all student records.  This includes Admission roll students 
that may be available within the RM Billing module. 
 
Billing categories are important when assigning subject costs to student records.  We will discuss 
subject costs in the next section. 
 

Activity: Set the Student Billing Category 

RM Billing > Students 

 Sort the students by clicking on the Year group column twice to bring the Year 12’s to the 
top. (or use the Find tool) 
 

 Select all of the Year 11 and 12 students 
 

 Click the For Selected menu 
 

 
 

 Select  Set Student Billing Category 
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 Choose Secondary (Chg) from the drop down list  
 

 
 

 Click OK to save 
 

 Select all of the Year 7, 8, 9 and 10 students 

 Choose Secondary (Vol, Chg) from the drop down list 
 

 
 

 Click OK to save 
 

 

 Select Simone Aspinall (Year 9) 

 Choose For Selected > Set Student Billing Category 

 Choose Full Fee Paying from the drop down list 
 

 
 

 Click OK to save 
 

Note:  District High Schools will need to assign their Primary Classes a Student Billing 
Category.  Years 1-6 students would be assigned the Category of ‘Primary’.  Pre-Primary 
students would be assigned the Category of ‘Pre-Primary’ and Kindy students would be 
assigned the Category of ‘Kindergarten’. 
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4.4 Subjects and Costs 

In RM Billing, it is possible to associate all timetabled subjects with their respective costs. Each 
subject may have a Voluntary component, a Charges component, a component for Adult Student 
Costs and a component for Temporary Visa Overseas Student costs. Within the software all 
components are optional – it is entirely up to the user to set the costs associated with each subject. 
 
Each cost has a related tax code (T) and Billing Code (Code). 
 
When the Subjects window opens for the very first time all subjects under the control of 
Timetabling for the current billing year will be loaded into RM Billing. Subjects which have been 
entered in the Administration module, but are not under the control of Timetabling will not be 
available in RM Billing. 

Note 1: If the Timetable has not been set up for the current billing year, the following 
message will be displayed. The Subjects window will open, but no subjects will be 
displayed for the current billing year.         

  

Note 2: The Timetable does not have to be finalised to use the Subjects section in RM 
Billing. The structure must be set up and the primary preferences entered for the students.  

 
The costs entered into the subjects table will be used on the Charges and Contributions Sheet for 
each student. 
 
RM Billing will use the primary preferences for each student from the Timetabling module and the 
appropriate cost/costs associated with each subject from the subject table in RM Billing. 
 

Note: There is an alternative method of billing for subject costs for years 7, 8, 9 and 10. For 
more information, log on to http://det.wa.edu.au/finance/detcms/portal/ to access the document 
RM Billing (Alternative Method for Timetabled Schools Yrs 7-10).   

  

http://det.wa.edu.au/finance/detcms/portal/
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4.5 Viewing and Assigning Subject Costs 

Activity: View Subject Costs  

RM Billing > Parameters > Subjects 

Most of the subjects we will use in Training for students have been allocated Subject Costs. 
 

 Click on the Charges column header twice to bring all those subjects with charges to the top 
of the list 

 

 
 

Notes:  Schools will determine the charges/costs associated with each subject. Subjects 
may run for a Semester or a Full Year. For new ATAR and General subjects, the beginning 
code AE or GE code represents the Course and Year Level of the students. In this 
instance AE stands for ATAR, Year Eleven.  GE stands for General, Year Eleven. 
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Activity: Assigning Subject Costs 

RM Billing > Parameters > Subjects 

 Click on the Code header twice to bring the GE subjects to the top 

 Highlight the GEPES Physical Education Studies General 11 and the GEOEC Outdoor 
Education General 11 subjects 

 

 
 

 Click on For Selected > Set Values 

 Place a tick in the Charges tick box   

 Enter the amount as 50 <Tab> 

 Enter GST code of 0 <Tab> 

 Choose the billing code for Upper School Charges (press <Tab> for a list) 
 

 
 

 Click OK to Save 
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4.6 Editing Subject Costs 

Activity: Editing Subject Costs 
 
We have since been advised that the GEPES Physical Education Studies General 11 and the 
GEOEC Outdoor Education General 11 subjects charges should have been set at $100 
 

 With the GEPES Physical Education Studies General 11 and the GEOEC Outdoor 
Education General 11 subjects still highlighted 

 Click Hide Unselected   

 Highlight the two subjects 
 

 
 

 Choose For Selected > Set Values 

 Select Charges 

 Edit the current amount to read 100.00 
 

 
 

 Click OK to save 

 Click on the Update Subjects after Timetable changes    to reload all Timetabled 
subjects 

 
Schools would continue to assign costs to other subjects for other years where they are charging 
students by the subjects selected. For training, we will only assign the Year 11’s their subject 
costs. 
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4.7 Printing Subject Costs 

A list of Subject Costs can be printed to check the information entered. 
 

Activity: Printing a List of Subject Costs 
 
We have been asked to produce a list of all subjects which have Charges associated with them. 

RM Billing > Parameters > Subjects 

 Click twice on the Charges column header to bring all subjects with associated charges to 
the top of the list 

 Highlight these subjects 

 Click Print Selected    (A portion of the report is displayed below) 
 
 

 
 

 Close the Selected Billing Subjects List 
 

Note:  Update Subjects   will repopulate all subjects when hide unselected has been 
applied.  Update Subjects also checks the Timetabling module for any subjects which have 
not been included in the RM Billing Subjects screen.  ie. recently created subjects 
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5 Creating Charges and Contributions Sheets 
In RM Billing, Charges and Contributions sheets are created based on a template. The sheets are 
not based on actual billing items. Therefore they can be created before any billing has occurred 
within the system.  
 

5.1 Charges and Contributions Sheet – Subject Information 

Subject information which needs to appear on the Charges and Contributions sheet is taken from 
the Primary Preferences held for each student in the Timetabling module along with the Subject 
Costs entered in RM Billing for those subjects.  
 
This information will automatically appear on the C&C sheet for each student. 

5.2 Charges and Contributions Sheet – Other Information 

Other information (such as Other Optional Costs, Government Subsidies etc.) which needs to be 
displayed on the Charges and Contributions sheet is entered manually by the user into a template. 
 

5.3 Creating a Charges and Contributions Sheet Template 

 

Activity: Create a Charges and Contributions Sheet Template 
 
Create a Charges and Contributions Sheet Template to be used for Year 11 students.  The  
information to be included on the Charges and Contributions Sheet is shown in the table below: 
 

Item Category GST Code Amount 

All subjects chosen by the 
student and their related 
costs (Year 11 Charges) 

To be picked up from Timetabling and the RM Billing 
Subjects table 

School Year Book Other Optional Costs 0 $20.00 

Chaplaincy Voluntary Approved 
Requests 

0 $15.00 
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RM Billing > Reports 

 With Charges and Contributions Templates highlighted on the left hand side, click  

  on the right hand side 
  

  
 

 The following screen appears: 
 

 
 

 Click Add    to create a new template. The template screen is displayed. 
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 Enter Year 11 as the name for the Template.  
 

 
 
The first part of the name is already created for you (2019 Charges and Contributions). Simply 
enter your own descriptor on the end. 

Note: The Subject information does not need to be entered because in this example we 
are picking up the subjects automatically from the student’s Primary Preferences in 
Timetabling. 

 Select the Other Optional Costs tab 

 Click Add   

 Type in the Other Optional Costs as illustrated below: 
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A blank line can be removed by a right mouse click and select Remove Line as shown below. 
 

 
 

 Select the Voluntary Approved Requests tab 

 Click Add   

 Type in the Voluntary Approved Requests as illustrated below: 
 

 
 

Notes: Schools should use the GST code for Chaplaincy which is appropriate for their 
circumstances.  

If a school identifies the amount they are requesting for the chaplain on the C&C sheet is 
a donation, the tax code is 0.  If the school is collecting on behalf of a church, the code is 
8. If the school is charging a fee for chaplain services, the code is 1. 
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 Click into the Footer Message and type ‘Please contact the School office on 9229 7777 if 
you have any queries regarding this Charges and Contributions Sheet or wish to 
arrange an advance payment.’ 
 

 

Note: The footer message can be entered or edited at any time 

 Click   and view the newly created template 
 

 
 
 

 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 62 of 322 

© 2019 Civica Pty Ltd 

 

5.4 Alternative Method of Billing for Timetabled Schools Years 7-10. 

The standard method for billing students involves using information from the student’s subject 
preferences from the timetable. 
 
There is an alternative method of billing which can be used for Timetabled Schools for students in 
Years 7 to 10.  This method involves a standard cost for the eight learning areas and using the 
student’s timetable for billing the costs for the subject charges with high cost options, for example, 
Outdoor Education. 
 

Activity: Creating a Template for Alternative Method of Billing 
 
A Template is required to advise Lower School Students of their Charges and Contributions.  
The Lower School Students have some of the same items as the Year 11’s, therefore the Year 
11 Template can be edited to create a new template. 

Items to be included 

Item Category GST Code Amount 

School Magazine Other Optional Costs 0 $20.00 

Chaplaincy Voluntary Approved 
Requests 

0 
$15.00 

Lower School Voluntary 
Contributions 

Voluntary Contributions 0 
$235.00 

 

RM Billing > Reports > Charges and Contributions Templates > Template Manager 

 Highlight the template for the Year 11 students 
 

 
 

 Click Edit   

 Change the name of the template to: Lower School 
 

 
 

 Select the Voluntary Contributions tab 

 Click Add   
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 Enter the Description Lower School Subjects-Voluntary Contributions 

 Enter the GST Code and Amount as shown below 
 

 
 

 Click Save 
 
The following message indicates that a blank line has been created. 
 

 
 
Locate the blank line and right mouse click and select Remove Line 
 

 
 

 Click Save 

 Close the View Charges and Contributions Templates window 

 Close the Reports window 
 

Note:  For more information log on to the  http://det.wa.edu.au/finance/detcms/portal/  to 
access  “RM Billing (Alternative Method for Timetabled Schools Yrs 7-10) “ 

 

http://det.wa.edu.au/finance/detcms/portal/
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5.5 Printing the Charges and Contributions Sheets from Students  

Activity: Viewing Student Information  
 
Before we produce the reports we will look at a sample student. 

RM Billing > Students 

 Double-click on the student record for Jacob Miller 

 View the Details tab 

 View the Subjects tab 
 

 
 

 View the Billing Items tab, you will see there is nothing there 
 

 
 

 Click Return to View  
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 Type Miller to highlight Jacob’s record 

 Click For Selected > Print Charges and Contributions 
 

 
 

 Select the Year 11 Template 
 

 
 

 Click OK 
 

 
 

 Click OK for Current Form 

 Click OK to send the report to the screen 
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 View and Close the Report 
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Activity: Producing Charges and Contributions Sheets from 
the Reports section 
 
Using the alternative method of printing a Charges and Contributions report for a Year 10 
student, Steven Bailey. We will print this from the Reports section. 

RM Billing > Reports 

 Open the Charges and Contributions Templates folder on the left hand side to display the 
templates which have been created 

 Select the 2019 Charges and Contributions –Lower School template 
 

 
 

Note: The Page Footer message can be edited at this point if required. Any changes made 
will be used for this print run only – they will not be saved to the template. 

 Click New Query  

 Type Bailey and click Find  

 Leave the Select Year/Form as Current  

 Click on the Print button, then OK to print to Screen 
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 View and close the report 
 
 

 

Note: When producing these reports for the following year, it is necessary to select the 
options for Proposed Year/Form.  The Proposed Year and Form must have been entered for 
the students in the Administration Manager module.  However, if the proposed year and 
form has not been set, the sheet will print with form and year “not specified”.  The primary 
preferences must have been entered for the student in the Timetabling module.  
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5.6 Printing Charges and Contributions Sheets from the Students 
section 

Charges and Contributions Sheets can also be produced from the Students section.  
 

Activity: Producing Charges and Contributions Sheets from 
the Students section 
 
Using the Alternative Method of Billing Template, print a Charges and Contributions report for a 
Year 10 student, Steven Bailey. 

RM Billing > Students 

 Highlight Steven Bailey 

 Click For Selected > Print Charges and Contributions 
 

 
 

 Select the Lower School  Template 
 

 
 

 Click OK  

 Leave Current Selected  

Note: Select ‘Proposed’, when producing the Charges and Contributions Sheet for the 
following year.  
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 Edit the footer message if required (any changes will be used for this print run only – it will 
not be saved to the template) 

 Click OK and OK print to screen 

 View and close the Charges and Contributions Sheet 
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Note: If the BPAY information on the Charges and Contributions Sheet is displayed, the 
Student Number (Formerly Curriculum Council number) for each student will be listed as 
the Reference.  Ensure these numbers have been entered into the datafile before displaying 
the BPAY information. This is particularly important for future Year 7 students for whom the 
numbers may not yet be available. The BPAY option can be turned on/off in Parameters > 
Billing Parameters, as required. 

IMPORTANT:   If the subject information is taken from Timetabling and 
the RM Billing Subject Table, then the subject information printed on the 
Charges and Contributions sheet will automatically change whenever a 
student’s preferences change. 
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6 Creating Billing Items for Students 
In RM Billing, Charges and Contributions sheets are not based on real billing items. In our training 
course so far, the students have not actually been billed for anything at all. 
 
When should actual Billing Items be created?  Considerations are: 

 Once the majority of student subject changes have taken place 

 Before statements can be produced 

 Before money can be receipted (unless the money is to be entered as unallocated credit)  
 

6.1 Subject Billing Items (using timetabled subjects) 

Once student subject changes have settled down, subject billing items should be created for all 
timetabled students. These billing items can be created in bulk for a group or groups of students. 
 
Subject Billing Items can be created automatically for all of the Primary Preferences entered for a 
student in Timetabling at the point at which the process is run. 
 
The process can only be run once for each student in each billing year.  If student subjects 
change after the billing items have been created, then the old subject billing items must be 
reversed and the new subject billing items created. (We will cover this later on in the training 
course). 
 

6.1.1 Creating Subject Billing Items 

RM Billing provides a routine to create the subject billing items automatically. This routine is 
available from the Utilities section. 
 

Activity: Create Subject Billing Items for Year 11 Students 
 
Create subject billing items for all Year 11 students. 

RM Billing > Utilities 

 Double-click Create Subject Billing Items 
 

 
 

 Click Yes 
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 Leave 2019 selected in the Billing Year window 
 

 
 

 Click OK 
 

 Click Student Find   

 Select Year Group 11 

 Click Find > Select > Yes 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

 
 

 
 

 Click OK and close the Utilities window 
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Subject Billing Items Exception Report 

If for any reason subject billing items cannot be created for a student/s, an exception report will be 
produced listing the name/s of the student for who billing items could not be created and the 
reason/s. 
 

 
 
 
The reason could be any of the following: 
 

 Student does not have a fees biller. 

 Student does not have a student billing category for the selected year. 

 Student is a Full Fee Paying student. 

 All related values in the subject table for this student are set to zero. 

 Student does not have any Primary Preferences in Timetabling. 

 Subject billing items have already been created for this student in the selected year. 
 

6.1.2 Checking the Subjects with No Billing Items Report 

The Timetabled Subjects and Billing Item Reports, provide users with a range of reports to assist in 
the management of student billing.   The Subjects with No Billing Items Report, will allow users to 
identify Billing Items for which a system generated Billing Item has not been created. 
 

Activity: View Subjects with No Billing Items Report 

RM Billing > Reports > Transactional Reports > Timetabled Subjects and Billing Items 

 Ensure the Billing Year is 2019 

 Click on New Query and select Year Group 11 

 Click  Find, Select then Yes 

 Select Subjects with no Billing Items   

 Click on Print 
 
A list of all students in Year 11 with Subjects without system generated Billing Items is printed. 
Note that we are not billing the students for Homeroom. 
 

 View and close 
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6.1.3 Checking Subject Billing Items 

Subject Billing Items can be viewed from two places – from the Student record or from the Subjects 
Billing Items batch. We will look at both. 
 

Activity: Checking Subject Billing Items 
 
Check the Subject Billing Items created for Jacob Miller and then for all of the Year 11 students. 

RM Billing > Students 

 Double-click Jacob Miller 

 Select the Billing Items tab 
 

 
 

 Click Print    to view a printout of the billing items 

 Close the Student details window 
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RM Billing > Billing Items 

 

 Double-click on the Subjects Batch 2019 

 Select the Batch Billing Items tab 
 

 
 

 Click Print    to view a printout of the billing items 

 Alternately highlight the items to be printed and click Print Selected    to print a selection 
 

 
  

 Close the Billing Items report 

 Click   Return to view 
 
 

 

Note: Clicking on the column Headers will make it easier to sort and select items. 
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6.2 Creating Other Billing Items 

Other (non-subject) billing items can be created by setting up Billing Item batches.  Billing Item 
batches can be created for any items for which students are to be billed.   
 
For example: 

 Voluntary Contribution amounts for Kindergarten, Pre-Primary and Primary students (for 
District High Schools) 

 Voluntary Contribution amounts for Lower School Secondary Students 

 Other Optional Costs 

 Voluntary Approved Requests 

 School Camps & Excursions 
 

Activity: Creating a Billing Items Batch Header  
 
Create a Billing Items batch for the Other Optional Cost of the School Year Book  which has 
already been listed on the Charges and Contributions Sheets. 
 
Remember that the students have not yet been billed for these costs (we have entered them in 
the Charges and Contributions template). 

RM Billing > Billing Items 

 Click Add Item   

 Select the billing year from the drop down list (only the current and future years are 
available) 

 Enter the description School Year Book 

 Click OK to save 
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Note:  Batch numbers are automatically created by RM Billing and are created sequentially 
beginning at 00001. Batch numbers are not re-used. 

6.2.1 Adding tied billing items 

Tied Billing Items are the actual Billing Items for which the students will be billed. 
 

Activity: Adding tied billing items to a batch header 

RM Billing > Billing Items 

 Click Add Debit   

 Enter the following tied billing item: 
 

 
 

 Click OK and  
 

Note: If there is more than one tied billing item to be entered into the batch, each line 
should be entered separately and saved (by clicking OK).  Each tied billing item must have a 
description beginning with the Billing Year, a GST code (a look up list operates by pressing 
<Tab>) and a Billing Code (a look up list operates by pressing <Tab>).  Ensure the correct 
billing code for each item is selected.  
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Activity: Review of Creating Billing Item Batches 
 

 Follow the method used above to create a billing items batch for the Voluntary Approved 
Request for Chaplaincy 

 

 
 

 Click OK  
 

 

Note: Schools should use the GST code for Chaplaincy which is appropriate for their 
circumstances.  

If a school identifies the amount they are requesting for the chaplain on the C&C sheet as a 
donation, the tax code is zero.   

If the school is collecting on behalf of a church, the code is 8.   

If the school is charging a fee for chaplain services, the code is 1. 
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6.3 Bulk Billing Students 

Once a billing items batch has been created, students can be ‘bulk billed’ using the batch. 
 

Activity: Bulk Bill Year 11 Students 
 
Bulk bill all theYear 11 students for the School Year Book and the Chaplaincy batches that we 
have just created. 

RM Billing > Students 

 Sort the student records by the Year column ( alternatively use the  to select Year 11) 

 Highlight all Year 11 students (Hint: Use Ctrl + A) 

 Choose For Selected > Add to Billing Item batch 
 

 
 

 Click OK  

 Highlight both the School Year Book and Chaplaincy batches (this can be done by 
dragging the mouse or by using <Ctrl> 

 

 
 

 Click OK 

 Double-click Jacob Miller and view his Billing Items tab 

 Close the Student Details window 
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6.3.1 Viewing billing items in bulk 

Each Billing Item batch will contain the billing items for all students who have been billed using 
those batches.  
 

Activity: Viewing Billing Items in a non-subject batch 
 
View all billing items which have been created using the Other Optional Costs for the School 
Year Book  batch. 

RM Billing > Billing Items 

 Double click on the School Year Book batch 

 Select the Batch Billing Items tab 

 Click Print List  to view a full list of billing items in this batch 

 Close the Billing Items report 
 

 Click on the Form column header to sort by form 

 Highlight all students in form 11.1 

 Click Print Selected   

 View and close the Billing Items report 

 Click Return to View  
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6.4 Alternative Method of Billing for Timetabled Schools Years 7-10 

Schools electing to use the Alternative Method for Billing Students in Year 7-10 must create a 
Billing Item batch for Voluntary Contributions. This Batch can be divided up into the approximate 
costs for Subjects for the eight Learning Areas. 
 

Activity: Create a Billing Item for Voluntary Contributions 

RM Billing > Billing Items 

 Click Add Item   

 Enter the description Lower School Voluntary Contributions 

 Click OK to save 

 Click on   and enter details for the first line 
 

2019 English 25.00 0 VOL01 

 

 Press enter and then press enter again 

 Enter the second line 
 

2019 Science 25.00 0 VOL01 

 

 Press <enter> and then press <enter> again 

 Continue until all lines have been entered 
 

 
 

 Click OK to save the billing item 
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Once a billing items batch has been created, students can be ‘bulk billed’ using the batch. 
 

Activity: Bulk Bill Year 10 Students 
 
Bill the Year 10 students except Jonathon Depete for the Other Optional Costs, the Voluntary 
Approved Requests and Voluntary Contributions batches that we have just created. 

RM Billing > Students 

 Click on Find Student  

 Select Year group 10 

 Click on Find,  

 Highlight all the Year 10 group except Jonathon Depete  
 
Hint: <Ctrl>+<A> to highlight all, then deselect Jonathon by clicking on his name 
 

 
 

 Click Select and Yes 

 Highlight the students (Ctrl+ A) 

 Choose For Selected > Add to Billing Item batch 
 

 
 

 Click OK  
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 Highlight the School Year Book, Chaplaincy and Lower School Voluntary Contributions 
batches (Click and drag down over the batches or Ctrl+A) 

 

 
 

 Click OK 

 Double-click Steven Bailey and view his Billing Items tab 

 Close the Student Details window 
 

 
 
 

IMPORTANT: 

 This method can be used by District High Schools for billing 
Kindergarten, Pre-Primary and Primary school students for their 
Voluntary Contributions.  Separate billing item batches will need to be 
created for each group (K, PP and P).  This is because the voluntary 
contribution payments must be posted against different Budget Codes 
in RM Finance. 
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7 Automatically Show Student Balances 

Activity:  Automatically Show Student Balances 

 

Once billing items have been applied to students, the current balance which is owed by each 
student is displayed in the balance column.  Users have the option of viewing the current 
balance once the billing item has been applied or only showing the balances when the ‘Show 
Balance’ checkbox is un-ticked and then selecting to click the ‘Show Balance’ tab in the 
student window. 

Note:  If a school has a large student population, it may take some time to load the 
Student screen after logging into RM billing. If the ‘Automatically show student balances’ 
is deselected in ‘Parameters > Billing Parameters’, the Student screen will open without 
calculating the balance of each student. Once the student screen has opened, the ‘Show 
Balances’ tab can be selected or the ‘Automatically show student balances’ tickbox can 
be checked to display student balances.  

 
RM Billing > Billing Parameters > General Tab 
 

 Click   

 Un –tick   
 

 Click OK    
 

 Close Parameters and the Billing Parameters window 
 

RM Billing > Students 
 

 Click on the Year header twice, scroll to view the Year 11 Students 

 Note that the balances have now been suppressed.  
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 Click the   to display the suppressed balances 
 

 
 
 

Note:  It may be necessary to sort by Year Group again in order to group the balances 

For training, we will keep the ‘Automatically Show Student Balances’ selected. Turn the 
option back on in RM Billing > Parameters > Billing Parameters 
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8 Government Subsidies 
Students qualify for Secondary Financial Assistance (SFA) if one of their parents/guardians is a 
holder of one of these eligible Concession Cards. 
 

 Centrelink Health Care Card 

 Centrelink Pensioner Concession Card 

 Veteran’s Affairs Pensioner Card (Blue Card) 
 
Parents/Guardians must complete an application form and these are then approved by the Schools 
Resourcing and Support Directorate at the Department of Education. 

8.1 Managing SFA Applications in RM Billing 

The latest version of RM Billing allows schools to complete and manage the forms and application 
process, as well as receipting of GV Subsidies.  
 
The steps in this process are: 
 

1. Application Forms are completed and printed from RM Billing 
2. Forms are signed by the Concession Card holder making the application 
3. Details of the Applications are exported to a text file 
4. The Exported files are emailed to Schools Resourcing and Support Directorate-Student Allowances 
5. Once approved, Import Receipt text files are returned to the school 
6. Receipt files are imported into RM Billing (This creates a receipts batch for GV Receipts) 
7. Imported  Receipts are created as Unallocated GV Credit for students in the Import file 
8. GV Credit can then be allocated to the student’s Billing Items 

 
The Secondary Financial Assistance Allowances available for students are: 
 

 Education Program Allowance (EPA) for $235 

 Abstudy Supplement Allowance (ASA) for $79* 

 Clothing Allowance (CLA) Payment for $115 (See Page 86 for further Important Notes) 

Notes: Government Subsidies must be applied to Billing Items in a specific order depending 
on their Student Billing Category. See Section 8.2.1 below for details.  

*The Abstudy Supplement Allowance is a top up payment for Indigenous students where 
their parent/guardian have already claimed $156 through their Centrelink payments. 

Clothing Allowance payments are classified as Parent Payments but are receipted as 
Government Subsidies (GV) payments where the parent has elected to allocate this directly 
to the school. 
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8.2 How are Government Subsidies handled in RM Billing? 

In RM Billing a Government Subsidy is a special type of receipt.  Government Subsidies need to 
be recorded against the students in RM Billing, but unlike other receipts, the subsidy money is not 
exported to RM Finance. This is because when the Government Subsidy money is received by the 
school, it is entered directly into RM Finance as a lump sum.   

8.2.1 Rules for Applying Government Subsidies  

The Government Subsidy is applied to the billing items for the selected year for each student in a 
particular order, according to the billing category of the student. The table below shows the order in 
which the types of billing items need to be paid by the subsidy. 
 
If completing this process using the For Selected > Apply Subsidies, the software will 
automatically allocate the subsidy based on the Business Rules outlined below. 
 

Student Billing Category Priority for applying subsidies 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Voluntary, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other 
item which has a category assigned (other than Not 
Applicable). 

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned (other than Not Applicable). 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any 
other item which has a category assigned (other than 
Not Applicable). 

Adult Students Adult student costs, Charges, Residential, Other 
Optional Costs, Voluntary Approved Requests followed 
by any other item which has a category assigned 
(other than Not Applicable). 

Full Fee Paying Overseas 
Students 

Not applied, since these students are not eligible for 
Government Subsidies. 

 

IMPORTANT:  

The EPA and ASA (if applicable) Receipt Batches need to be imported 
into RM Billing before and separately to the CLA Receipt Batches. The 

receipt batch for the EPA and the ASA need to be applied to the 
students Subject Billing Items first or if Auto Allocating then the EPA 
will apply as per the Business Rules above. When these receipts have 
been applied then the CLA receipt should be applied to the student.  

Even though the CLA is now paid to the school as a Government 
Subsidy, it is parent money and can be refunded to the parent if there is 

an unallocated credit balance at the end of the year. 
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8.3 Completing Secondary Financial Assistance Applications 

Secondary Financial Assistance Applications are completed from the Student screen in RM Billing. 
The person making the application (Parent or Guardian) must be present to sign the printed 
application and to produce the Concession Card they are using to make the application. 

8.3.1 Completing a SFA Application Form  

Activity:  Complete the SFA Applications 

RM Billing > Students 

 Highlight David Maroney 

 Click For Selected > Secondary Financial Assistance Applications 
 

 
 

 Highlight his Mother from the Contact list 
 

 
 

 Click OK 

 Select the Secondary Assistance Scheme 
   

 
 

 Click OK 
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The Secondary Assistance Form will display. 
 

 Complete the Concession Card Details 

 Tick the box for School for the Clothing Allowance Payment 

 Tick the boxes for the Parent/Guardian Declaration 
 

 

Note: If the application date is later than the cut off date of 12th April 2019, a Late 
Justification reason needs to be added.  
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 Click Print 

 Click Yes to Include the Late Application Justification 
 

 
 

 Click OK to the Print Application message 
 

 
 

 Click Yes to the second Print message 
 

 
 

 Click Yes to the Complete Application message 
 

 
 

 Click OK to the Application Complete message 
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Note: If Save and Close is selected the Application remains incomplete. It must be edited 
and printed to be included in the export file. 

Sample Printed Application Form 
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8.3.2 Viewing a Completed SFA Application  

Activity: View the Application in the Student Record 

RM Billing > Students 

 Open the Student Record for David Maroney 

 Click on the Sec Fin Assist tab 
 

 
 
A printed (completed) form will display as Pending before the record is exported. 
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8.3.3 Editing an Incomplete SFA Application  

An Application which is saved and closed rather than printed, will remain marked as Incomplete 
until it is printed. 
 

Activity: Edit an Incomplete SFA Application 

RM Billing > Students 

 Right Click on Maroney and Type LAM 

 The Student Record for Chanara Lam will display 
 

 
 

 Click on the Edit icon  

 Chanara’s application will open 
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Chanara’s mother has elected to receive the Clothing Allowance in her own account, however 
she did not have her Bank Details with her when making the application. 
 

 Complete the BSB and Account Number information 
 

 
 

 Add a late reason (only necessary after the cut-off date) 

 Click Print 

 Click OK and Yes to all the messages 
 
 

 
When finished, the application will display as Pending. 
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8.3.4 View the SFA Application Report 

A Report can be printed to show all the SFA Applications. It can also be filtered to display those 
with different statuses. 
 

Activity: Printing the SFA Application Report 

RM Billing > Reports  

 Open the Transactional Reports Folder 

 Highlight the Secondary Financial Assistance Summary report 
 

 
 

 Leave all the default settings (Prints ALL Applications for the current year) 

 Click Print 
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The Report will display all applications, the type of funding applied for, the Status of each 
Application and whether the Clothing Allowance is being paid to the school or parent. 
 
 
 

 
 

 Close the report and the Reports screen 
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Important Notes for SFA Applications 

Signatory and Witness 

The Concession Card Holder must be the signatory on the Form. The Concession Card must be 
sighted by the school witness. 

Incomplete or Editing Applications 

Applications can be Saved and Closed and will display in the student record as Incomplete. These 
can be edited and printed at a later date. 
 
Completed Applications can be edited however a warning will appear prior to opening the 
application, as shown below. 
 

 

Cut-Off Dates for Applications 

The Cut-Off date for applications will be communicated to schools each year but is generally the 
end of Term 1.  For 2019, forms must be returned to the Schools Resourcing and Support 
Directorate for processing before the 12th of April 2019. 
 
Applications submitted after this date will need to have a Late Application Justification reason 
added to the form prior to printing. 
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8.3.5 Export SFA Applications 

Secondary Financial Assistance Applications can be exported any time there are completed 
applications. Schools may wait for all their applications to be completed and send the export just 
once, however the export process can be done multiple times. Applications that have been marked 
as sent will not be exported again. 
 

Activity: Export SFA Applications 

RM Billing > Utilities 

 Double Click on Export Secondary Financial Assistance 
 

 
 

 Check the email address that will be used for SFA correspondence 
 

 
 

 Click Yes 

 The File will be exported to the default pathway set up in Billing Parameters 
 

 
 

 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 100 of 322 

© 2019 Civica Pty Ltd 

 

 

 Navigate to C:/Keys/RMDB/SECONDARY ASSISTANCE 

 Double click on the SFA file 

 View the exported file  
 

 
 

Note: For schools the default pathway for export files will be K:\RMDB\FINANCE\ 
SECONDARY ASSISTANCE. 

This file contains the details of all the students who had a completed SFA application. The file 
needs to be emailed as an attachment to Student.Allowances@education.wa.edu.au. The 
applications will be processed and an Import Receipts file will be emailed back to the email 
address displayed when first exporting the applications. 
 

 Double Click in the File to open 
 

 
 

Notes: Files are named with the School Code and the Date and Time the file was exported. 
This ensures every exported file is uniquely named. 

 

 
  

mailto:Student.Allowances@education.wa.edu.au
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8.4 Importing SFA Receipts 

It is important that schools import SFA receipts using the process outlined in these Training Notes 
or according to the processes provided in the Schools Resourcing and Support documentation on 
the Finance Web. 
 

8.4.1 Import Files 

Import Files containing the details of SFA subsidies will be emailed back to schools. Education 
Program Allowances (EPA) and Abstudy Supplement Allowances (ASA) and Clothing Allowance 
(CLA) receipts will be in separate files.  All imported Payments are processed in RM Billing as 
Government Subsidy (GV Payment Type).   

Sample Import Files 

Education Program Allowance (EPA) 
 

 
 
Clothing Allowance (CLA) 
 

 
 
Abstudy Supplement Allowance (ASA) 
 

 
 
These files should be placed in the same folder used for exporting SFA Applications. The file path 
is set up in RM Billing > Parameters > Billing Parameters. 
 

8.4.2 Import Order and Receipt Allocation 

When Importing SFA Receipts for students, receipts should be imported in the order below. Each 
Education Program Allowance Receipt (EPA) and Abstudy Receipt (ASA) should be allocated to 
the student’s Billing Items before importing any Clothing Allowance Receipts (CLA). 
 

1. Education Program Allowance (EPA) Receipts 
2. Abstudy Receipt (ASA) Receipts 
3. Clothing Allowance (CLA) Receipts 
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8.4.3 Import and Allocate EPA Receipts  

Activity: Import EPA Receipt Files 

RM Billing > Utilities 

 Double Click on Import Secondary Financial Assistance 
 

 
 

 Open the Secondary Assistance folder  
 
The software will default to look for the Import Files in the default pathway set up in Billing 
Parameters.  
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 Double click on the EPA Receipts file 

 Click OK to the Import message 
 

 
 

 Click Yes to Print the Detailed Receipt Summary Report 
 

 
 

 Click OK to send the report to the default printer 

 Click Yes that the Report has printed OK 

 Click OK to finish 
 

 
 

Note: The Receipts batch is automatically closed once the Import is complete. The 
Receipts Summary Reports can be re-printed at any time from the Receipts screen (see 
Activity below). 
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Activity: Checking the Imported EPA Receipts Batch 

RM Billing > Receipts 

 Double click on the Imported EPA Receipts Batch 
 

 
 

 Click on the Batch Receipts Tab 

 Highlight one of the Receipts 

 View that the Receipts display as Unallocated Credit 
 

 
 

 Click Return to View  

 Highlight the Imported EPA Receipts Batch 

 Go to For Selected and Print Receipts Summary 
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 Click OK to the screen and Yes for the Detailed Summary 
 

 
 

 View the Receipts Summary Report  
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Activity: View Unallocated Credit from Imported EPA Receipts 

The Imported EPA Receipts are allocated directly after the import process for all students in the 
file. This can be done per student or by using the Auto Allocate option for multiple students. 
Schools can check the Imported Receipts batches and/or the Unallocated Credit Listing to see 
which students have credit due to the import of a subsidy receipt. 

Important: If using the Auto Allocate function schools must allocate 
the credit in order according to the rules for allocating Government 

Subsidies outlined in Section 8.2.1 of these Training Notes. 

RM Billing > Reports > Financial Reports 

 Highlight the Unallocated Credit Listing report 
 

 
 

 Click Print and OK to send the report to the screen 
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Unallocated Credt Listing showing GV Credit 
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8.4.4 Allocate EPA Government Subsidy Receipts in Students 

The Government Subsidy Receipts can be viewed in the Student Records on the Receipts tab. 
All imported receipts will display as Unallocated Credit. This Unallocated Credit should be allocated 
as soon as possible to the student’s Billing Items. This can be done per student or by using the 
bulk Auto Allocation process. This will be shown later in training. 
 

Activity: Allocate Government Subsidy Credit 

RM Billing > Students 

 Locate David Maroney and open his record 

 Click on his Receipts Tab 

 View the Receipt for Education Program Allowance  
 

 
 

 Click on the Billing Items tab 

 View David’s Unallocated Credit 
 

 

Note: Before allocating the credit, it is important to remember rules regarding the order 
for paying off Billing Items with Government Subsidies. Refer to the table in Section 8.2.1 
for full details. 
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 Highlight David’s subject costs 
 

 
 

 Click Allocate 

 Enter $235 and click OK to allocate the GV Credit 
 

 
 

 Click on Show Billing Items with Outstanding Amounts 

 View the remaining items with a balance to pay 
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 Right click on Maroney and type Lam and press <Enter> 

 Repeat the steps above to allocate Chanara Lam’s GV Credit to her subject costs 
 

 
 

 
 

 Click on Chanara’s Receipts tab 

 Highlight the Imported EPA Receipt 
 

 
 

 View the changes in the allocation of the receipt 

 Close Student Details 
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8.4.5 Import and Allocate Abstudy Receipts in Students 

Activity: Import Abstudy Receipts 

RM Billing > Utilities 

 Double Click on Import Secondary Financial Assistance Receipts 
 

 
 

 Select the ASA Receipts file and click Open (or Double Click) 
 

 
 

 Click OK to the message 
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 Click Yes for the Detailed Receipt Summary 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

  
 

 Click OK 
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Activity: View and Allocate Abstudy Receipts 

RM Billing > Receipts 

 Double click on the Imported ASA Receipts 
 

 
 

 Click on the Batch Receipts tab 

 Highlight the Imported ASA Receipt for Ariel Mahney 
 

 
 

 Close the Receipts screen 
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RM Billing > Students 

 Open Ariel Mahney’s record 

 View the Abstudy Receipt on the Receipts tab 
 

 
 

 Click on the Billing Items tab to view the unallocated credit 
 

 
 

 Highlight the first two subject Billing Items 
 

 
 

 Click  

 Enter $79 and click OK 
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8.4.6 Import and Allocate Clothing Allowance Receipts in Students 

Activity: Import Clothing Allowance 

RM Billing > Utilities 

 Double Click on Import Secondary Financial Assistance Receipts 
 

 
 
The software will default to look for the Import Files in the default pathway set up in Billing 
Parameters.  
 

 
 
 

 Double click on the Clothing Allowance Receipts file 

 Click OK to the message 
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 Click Yes for the Detailed Receipt Summary 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

  
 

 Click OK 
 

 
 

 View the Imported Receipts in RM Billing > Receipts 
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Note: If a Receipts file has already been imported, the software will not allow it to be 
imported again. If this is attempted, a message will display (as shown below). 

 

Note: A log file is also created on import of receipts. This will be available to view in the 
default pathway. A sample is shown below. 

 To view a log file navigate to C:/Keys/RMDB/SECONDARY ASSISTANCE 
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Activity: Allocate the Clothing Allowance GV Credit 

RM Billing > Students 

 Open David Maroney’s record 

 Click on the Receipts tab to view the imported Clothing Allowance Receipt 
 

 
 

 Click on the Billing Items tab 

 Click on  

 Highlight David’s remaining subject costs 
 

 
 

 Click  
 

 Allocate the $115 credit 
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 Click OK 
 

 Click on  
 
All David’s subjects except for Physical Education has now been covered by the SAS 
 

 
 

 Click on the Receipts tab 

 The two imported receipts are now fully allocated 
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Activity: Check Unallocated Credit 
 
The Unallocated Credit Report will show all students with credit, including credit created by 
importing Secondary Financial Assistance receipts. 

RM Billing > Reports 

 Open the Financial Reports Folder 

 Highlight the Unallocated Credit Listing report 
 

 
 

 Click Print and OK to Screen 
 

 
 
There should be no unallocated credit. 
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9 Review  

Activity: Review-Billing Items 
 
The 2019 Year 11 students will be attending a camp. 
 
The cost of the camp is $300.00 and has been broken into the following items: 
 
Camp Activities:   $100.00 (GST code 0) 
Camp Transport: $50.00 (GST code 0) 
Camp Food:  $150.00 (GST code 1) 
 

 Create a Billing Items batch for the above Camp.  (Hint: Billing Items > Add). 
 
When adding the tied billing items use the Billing Code that you created earlier for school camps 
for each billing item. 
 

 
 

 Bulk bill all the Year 11 students for this camp. (Hint: Students > For Selected > Add to 
Billing Item Batch) 
 

 What is the total amount received if all these students attend? _________________ 
 
(Hint: Billing Items > Batch Billing Items) 
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The Modern History ATAR 11 students will be attending an exhibition at the Museum of WA 
 
Create a Billing Item and bill the Modern History HIM ATAR 11 (AEHIM)  students for this 
excursion 
 

 
 
Apply the Excursion billing item to the Year 11 Modern History ATAR students 
 
Hint: When applying the billing item search for students by subject 
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10  Individual Billing 
Billing items can be added to an individual student if required. 
 

Activity: Billing an Individual Student 
 
Emma Smithers has been given special permission to attend the camp. Bill Emma Smithers for 
all of the Camp charges. 

RM Billing > Students 

 Click  to load all students 

 Open Emma Smither’s record 

 Click on the Billing Items tab 

 Click on the Add Billing Item button   

 Choose Add to Billing Item Batch 
 

 
 

 Click OK  
 

 
 

 Click OK  

 Choose the Year 11 Camp Billing Items batch 
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 Click OK 
 

 
 

 Keep this window open 
 

 

11  Editing the Amount of a Billing Items Batch 
Users are able to edit details of the batch before applying it to a student’s record.  This allows 
users to customise billing details to meet individual needs as they process billing items. These 
changes are only reflected on the individual account for which the details have been edited.  The 
original billing item will remain unchanged. 
 

Activity: Edit the Batch Amount 
 
Frank Bishop has also received permission to attend the school camp.  The camp is scheduled 
to run over four days and Frank will be attending only two days of the camp.  We will edit the 
amount of the tied billing items before applying it to Frank’s records.   

RM Billing > Students 

 Right click in the red Surname cell 

 Type in Bishop 

 Press < Enter> 

 Scroll to Frank Bishop’s record 

 Click on the Billing Items tab 

 Click on the Add Billing Item button   

 Choose Add to Billing Item Batch 
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 Click OK 
 

 
 

 Click OK 

 Highlight the Year 11 Camp billing items batch 

 Click on   

 Highlight the Camp Activities line 

 Click on Edit   

 Change the amount to 50.00 

 Click on    to save the changes 
 

 

 Follow the steps above to edit the Camp Food charges to 75.00 
 
Frank will be providing his own transport to and from camp, therefore, the Camp Transport line 
can be deleted. 
 

 Highlight the Camp Transport line 
 

 

 Click on Delete Debit   and Yes 
 

 
 

 Click OK and view the edited billing items 
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12 Discounts 
Discounts can be applied to any type of billing item (both subject and non-subject) within RM 
Billing. The method for discounting is the same no matter what type of billing item is selected. 
 
A discount may be applied in the case of a student arriving at the school part-way through the year. 
In this case the student may be entitled to a discounted cost for their subjects. 

12.1 Discounts via Student Records 

Activity: Applying a Discount via Student Records 
 
Jonathon Depete, Year 10, has arrived at the school half way through the year. He is entitled to 
a 50% discount on his voluntary contributions.  

RM Billing > Students 

 Right click in the red Surname cell and load the record for Jonathan Depete 

 Click on the Billing Items tab 

 Click on the Add Billing Item button   

 Choose Add to Billing Item Batch  
 

 
 

 Click OK 
 

 
 

 Click OK  

 Select the Batches as shown below 
 

 
 

 Click OK 

 Highlight all of the Voluntary Contributions billing items 
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 Click Add Discount   

 Enter 50 as the discount percentage 

 Enter a reason for the discount July 2019-Commenced Term 3 
 

 
 

 Click OK and view the changes to the Discount, Balance and Reason columns 
 

 
 

IMPORTANT:   

The month and year must be typed in a consistent manner in the reason 
for the discount.  This is so the Transaction Summary report can be 

sorted via reason containing the month and year, which is most useful 
for end of month reporting. The Transaction Summary report is used to 
report on Discounts each month. It can be filtered by month to select 

Discounts for End of Month Reporting. 
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Activity: Review of Adding Discounts 
 

 Nathan Leslie has received a full scholarship from the School Council for Indonesian Second 
Language ATAR 11. Discount this subject by 100%. 

 

 
 

   Click  
 

 
 

 Livvy Lipton is being given her School Year Book for her contributions to the production of 
the document (funded by the School Council).  Discount this item by 100%. 
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12.2  Bulk Discounts via Billing Items 

The Batch Billing Items window allows the user to discount, or to remove a discount from a number 
of Tied Billing Items for a number of students, at the same time.   
 

Activity: Apply Bulk Discounts 
 
The Modern History ATAR 11 students have been billed for the Museum of WA excursion. 
 
We have been advised that some students have ‘Friends of The Museum’ membership and 
therefore qualify for a 50% discount for this excursion.   
 
Apply a discount to the following students 
 

Chelsea Kraft 

Khalid Moor 

Corey Ramsay 

Bradley Uifelean 

RM Billing > Billing Items 

 Double click on the Museum of WA Excursion batch 

 Click on the Batch Billing Items tab 

 Click on  (this ensures that the balances owing on the billing items 
after adjustments, if any, are displayed) 
 

 Highlight the required students  
 

 
 

 Click  

 Enter details as shown below 
 

 
 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 130 of 322 

© 2019 Civica Pty Ltd 

 

 

 
 

 Click OK 
 

 
 

 Close the Billing Items Screen 
 

Note: Transactions which have been Reversed (R) or are the Reversal Transaction (V) 
cannot be discounted. Transactions which have been Adjusted (A) or are the Adjustment 
Transaction (T) cannot be discounted.  Transactions which have already had a discount 
applied will have to have the original discount removed before applying the new discount. 
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12.2.1 Reporting on Discounts 

The Transaction Summary Report can be used to report on discounted items. 
 

Activity: Report on Discounts 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Click on the Transaction Summary 

 Ensure the Billing Items radio button is selected 

 Delete the default dates 

 Click on the Billing Options tab 

 Place a tick in the ‘Show discounted billing items only’ box 
 

 

 
 

 Click Print 
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A portion of the report is displayed below 
 

 
 

 Close the report 
 

 
Produce the report to show only items which were discounted this month.  This is a mandatory 
report and is required to be printed at the end of each month and signed by the Principal. 
 

 Select the Other tab 
 

 
 

 In the Reason containing, type the required month followed by the current year - 2019 

 Click Print 
 
A portion of the report is displayed below 
 

 
 View and close the report 
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13  Charges and Contributions Reports 
There are two useful reports in RM Billing which relate to Charges and Contributions amounts. We 
will look at each of these in turn. 

13.1 Charges and Contributions by Department report 

This report has been designed to help schools determine their budgets for the following year.  It 
displays the number of students that have chosen a particular subject along with the costs for the 
subject.  The report is grouped by department.   
 

Activity: Print Charges and Contributions Report 

RM Billing > Reports 

 Open the Charges and Contributions Reports folder 

 Click on the Charges and Contributions by Department report 

 Tick New Page per Department 

 Enter the percentage of total as 80 

 Click New Query  

 Use the find tool to select all students on the current roll 

 Enter the report message as per the screenshot below:  
 

 

Note: This message will be saved for the next time the report is run 

 Click Print and OK to print to screen 

 View and close the report 
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A portion of the report is displayed below 
 

 

 
 

 View and Close 
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13.2  Outstanding Amounts by Category Report 

This report enables school to print a report which classifies the amounts owed by students into 
their billing category. 
 

Activity: Print the Outstanding Amounts by Category Report 

RM Billing > Reports 

 Open the Charges and Contributions Reports folder 

 Click on the Outstanding Amounts by Category report 

 Click New Query  

 Use the find tool to select all students on the current roll 

 Tick the New Page with Subtotals Checkbox 
 

 
 

 Click Print and OK to print to screen 

 View and close the report 
 

 Uncheck New Page with Subtotals 

 Print and view the report 
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14  Receipting 
All receipts entered into RM Billing must be placed into a receipts batch.  Receipts batches must 
be created before the receipts are entered.   
 
The following conventions should be followed when creating receipts batches.    
 

14.1 Separate Receipts Batches 

Create separate batches for the following options: 
 

 General Banking (daily takings – cash and cheques) 

 Electronic Funds Transfers which include electronic credit card payments 

 Direct Deposits, such as payments from Centrelink or Family and Children’s Services 

 BPAY 

 Corrections  

 Refunds 

 Government Subsidies (special type of receipt – not exported) 
 
It is important that you separate the different types of receipts. This will make reconciliation in RM 
Finance much easier.  
 
For example, a general banking batch containing cash and cheques should be closed off when you 
are ready to bank the money.  The batch total in RM Billing (which is transferred to RM Finance) 
will match the deposit amount that is taken to the bank.  When you reconcile in RM Finance, the 
same batch total will appear on the bank statement and also in RM Finance making it easy to 
reconcile.  
 
If you enter other types of receipts into the batch which are not banked, the batch total in RM 
Billing and RM Finance will not match what is on the bank statement. 
 

14.2 Naming Receipts Batches 

The Receipts batch number will be automatically created by RM Billing. It will always begin with the 
letter ‘B’ followed by a sequential 5 digit number beginning with 00001.  
 
When naming a receipts batch, the description should contain the type of batch and the date it was 
created (dd.mm.yy). 
 
For example: 
General Banking 11.02.19 
Electronic Funds Transfer 11.02.19 

Note: For receipts entered retrospectively from receipt books or Z tapes, enter the comment 
“Duplicate- original receipt #xxxx” or “Duplicate-original Z tape #xxxx” as required   

Note:  For more information log on to http://det.wa.edu.au/finance/detcms/portal/  to access 

“Procedures for RM Billing Receipts batches.” 

  

http://det.wa.edu.au/finance/detcms/portal/
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Activity: Creating Receipts Batches 
 
Create the following two receipt batches using today’s date: 
 

 General Banking dd.mm.yy 

 Electronic Funds Transfer dd.mm.yy 
 

RM Billing > Receipts 

 Click Add  

 Enter the description and today’s date 
 

 
 

 Click OK to save 

 Repeat the process to create the Electronic Funds Transfer receipts batch 
 

 
 

 View the newly created receipts batches in the Receipts Batches List View window 
 

 
 

 Close the Receipts Batches List View window  
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14.3 Receipt Payment Types 

The following standard payment types exist in RM Billing and need to be used when entering 
receipts onto the system. 
 
CA Cash 
CH Cheque 
CR Credit Card 
EF EFTPOS 
BP BPAY 
DD Direct Deposit 
GV Government Subsidies 
 

14.4 Methods of Receipting 

There are a number of different methods that can be used for entering receipts into RM Billing.  
The method used will depend upon the circumstances. 
 

14.4.1 Receipting Methods 

There are five methods users may select from when processing receipts, including the Apply 
Subsidies option.  Each has features to assist with individual receipting needs. 
 

Receipt 
Process 

 Features Type of Payment 

Apply Subsidy 
(Manually) 
 

Students>For Selected>Apply 
Subsidy 
 

Payment is 
automatically 
allocated to billing 
items according to 
business rules 

GV only 
 $235 Education Program 
Allowance  
 

Import Subsidy Utilities>Import Secondary 
Financial Assistance Receipts 

Payment is 
imported as 
Unallocated 
Credit and is then 
applied to Billing 
Items 

GV Only 
$235 Education Program 
Allowance 

Apply Receipt 
(Bulk Process) 

Students>For Selected>Apply 
Receipt 

Payment is 
automatically 
allocated to billing 
items according to 
business rules 

CA, CH,CR,EF,BP,DD 

Add Receipt for 
Billing Items 
(Bulk Process) 

Billing Items> Batch Billing Items> 
Show Outstanding Balances> Add 
Receipt 

Allows users to 
receipt payments 
of the same billing 
item, amount and 
payment method. 

CA, CH,CR,EF,BP,DD 

Bulk Receipts  
(Bulk Process) 

Receipts>Receipt batch>Bulk 
Receipts 

Allows users to 
receipt via 
payment type. 
Users select the 
billing items to be 
paid. 

CA, CH,CR,EF,BP,DD, 
GV 
 
Ensure correct payment 
batch type is selected 

Add Receipt Student Record>Add Receipt Payment is 
automatically 
allocated to billing 
items.  Users may 
edit allocations. 

CA, CH,CR,EF,BP,DD 
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14.4.2 Bulk Receipting via the Billing Item Batch  

Bulk Receipting for the same Billing Item (via the Billing Items batch) is a useful method if a group 
of students are all paying the same amount for the same billing item(s).  For example, a group of 
students are all paying $300 for their Camp Charges. The Payment Type (e.g. Cash or Cheque) 
must also be the same for each group entered. 
 

Activity: Enter Bulk Receipts for the same Billing Item 
 
The following students have all paid in full for their Camp Charges.  Follow the instructions below 
to enter these receipts in bulk via the Billing Items batch. 
 

Name Payment Type Amount Paid 
 

Ryan Cooper CHEQUE  300 

Renee Dexter  CHEQUE  300 

Simon Rumble CHEQUE  300 

Jillian Sorrell CHEQUE  300 

Total Amount Paid 1200 

RM Billing > Billing Items 

 Double-click on the Year 11 Camp batch 

 Click on the Batch Billing Items tab 

 Click    (this ensures that the balances owing on the billing items 
after adjustments (if any) are displayed) 

 Click on the Student/Cust column heading to sort the list 

 Highlight all three billing items for each of the above students 
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Note: The Selected Totals Amount should match the total combined amount being paid. 

 Click Add Receipts for the selected billing items   

 Enter the General Banking receipts batch or press <Tab> for a list   

 Type in the total amount for all students of 1200 (this is the selected total) 

 Enter the payment type of Cheque (CH) or press <Tab> for a list 

 Enter a comment 
 

   
 

 Click  OK and Yes  
 

  
 

 Click  Yes  
 

 
 

 Choose Receipts  

 Click OK and OK to print to screen 
 

 
 

 View and close the receipts 
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14.4.3 To print receipts at another time 

 Choose Students  

 Select the appropriate student 

 Choose the Receipts tab 

 Select the appropriate receipt in the top half of the window 

 Choose the Printer icon  
 

Activity: Review of Entering Bulk Receipts via the Billing Items 
Batch 
 
Use the same method to enter the receipts for those students who have paid by Cash. Print the 
receipts to the screen. 
 

Name Payment Type Amount Paid 
 

Ashleigh Campbell CASH 300 

Shane Casson CASH 300 

Paul Hogan CASH 300 

Total Amount Paid 900 
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14.4.4 Bulk Receipting for a mixture of items via the Receipts batch 

This method is useful for processing a group of receipts which are mixed in nature. For example, 
different students are paying different amounts with various payment types for different items. 
 

Activity: Entering Bulk Receipts for a mixture of items 
 
The following payments have been received. They are mixed in nature.  They are for different 
amounts, different payment methods have been used and they are for different items. 
 

Name Amount Paid Payment Type Payment For 

Ashleigh Campbell $335 Cheque Balance of account 

Michael Fulter $400 Cash Subject charges  

Marc Kitchen $300 Cheque Year 11 Camp 

Jessica Lornab $100 Cash Outdoor Education General 

 

RM Billing > Receipts 

 Double-click the General Banking batch 

 Select the Bulk Receipts tab 

 Click Add Receipts   

 Enter the student’s surname (or part thereof) in the Student Name field and <Tab> to select 
the student from a list 

 Enter the amount <Tab> 

 <Tab> in the items field 

 Highlight the items to be paid, click OK and <Tab> 

 Enter the payment type (or press <Tab> for a list) <Tab> 

 Enter a comment (e.g. Balance of Account) 

 <Tab> to move to the next line  

 Repeat this process for the next student 
 

 
 

 Once all receipts have been entered, click OK to save 

 Click Print  
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 Click OK to view the Receipts 

 Close the receipts 
 

 Leave the General Banking window open  
 

Note: If a blank line is created in error, right mouse click on the blank line and select 

Remove line.    

 

IMPORTANT  

The receipts are not saved until the OK button at the bottom of the 
screen is clicked. It is therefore recommended that shorter lists are 

entered and saved regularly to minimise loss of data in the event of a 
power failure etc. 
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Activity: Receipting Overpayments 
 
Rhys Fitton wishes to pay $570 by cheque for his Charges and Contributions.  Currently his 
Billing Items total $270.00.  The overpayment will be processed as unallocated credit. 

RM Billing > Receipts > General Banking 

 Select the Bulk Receipts tab 

 Click Add Receipts   

 Type Fitton and <Tab> to select him 

 Type 570 in the amount 

 <Tab> in the items field and select all items  
 

 

 
 Click OK 
 

 
 

 Click Yes 

 <Tab> in the Type column and select Cheque 

 Type in comment Balance of Account 

 Click OK 
 

 
 

 Click on Return to View  
 

Note: The overpayment will be recorded as unallocated credit within Rhys Fitton’s record.  
The amount will be posted against the Billing Suspense Account N3199 in RM Finance. 
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14.4.5 Bulk Receipting for Charges and Contributions (via Students > Apply Receipts) 

This method is useful if a group of students are all paying the same amount for charges and 
contributions.  The system will automatically allocate the entered amount to each student to pay 
off their Billing Items in a specified order, according to regulations.  If the amount of the receipt is 
greater than the amount owing for the specified categories, then the additional amount will become 
unallocated credit (i.e. a credit amount which is not assigned to any billing items). 
 
Billing Items will be paid off in the following order:   
 

Student Billing Category Priority for applying receipts 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Charges, Residential, Voluntary, Other Optional Costs, 
Voluntary Approved Requests followed by any other item which 
has a category assigned including Not Applicable.   

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which has a 
category assigned including Not Applicable. 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 

Adult Students Adult Student Costs, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any other 
item which has a category assigned including Not Applicable. 

Full Fee Paying Overseas 
Students 

Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which has a 
category assigned including Not Applicable. 

  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 146 of 322 

© 2019 Civica Pty Ltd 

 

Activity: Bulk Receipts via Students 
 
The following year 10 students have all paid $235 for the balance of their Voluntary 
Contributions by EFTPOS. Enter receipts for the student payments in the table below. 
 

Student Payment 

Ben Anderson $235 

Steven Bailey $235 

Michael Brogan $235 

Emily Gold $235 

RM Billing > Students  

 Use Student Find    to find all Year 10 students 

 Highlight the students listed in the table above 
 

 
 

 Click For Selected > Apply Receipts  

 Click OK to the 2019 Billing Year 

 Enter the EFT receipts batch or press <Tab> for a list 

 Type in the amount that will be applied to each student $235 

 Press <Tab> and select the payment type for EFTPOS 

 Enter a Comment 
 

 
 

 Click OK 

 Close the Students window 
 

IMPORTANT: The amount entered is applied to each student record.  
This functionality can only be used when each student has paid the 

same amount  
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Activity: Printing Receipts for Bulk Entries 

RM Billing > Receipts  

 Double-click on the required batch (Electronic Funds Transfer) 

 Choose the Batch Receipts tab 

 Highlight the receipts to be printed at the top section of the screen 

 Click Print    > Yes > OK and OK to print to screen 

 View and close the receipts 

 Click Return to View  
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14.4.6 Individual Receipting  

This method can be used to enter a receipt for an individual student. 
 

Activity: Entering an Individual Receipt 
 
Maureen Kent, Clayton Kent’s grandmother, has come to the front office to pay for his Subject 
Charges. She has a cheque for $300. As she is not the nominated fees biller, the received from 
details will be edited to reflect the payment is from someone other than Mr. Roy Kent. 

RM Billing > Students 

 Double-click on the record for Clayton Kent 

 Select the Receipts tab 

 Click Add Receipt    
 

 Press <Tab> for a list of open receipts batches 

 Select the General Banking batch for today and Click OK 

 <Tab> to move to the Payment Type field 

 <Tab> to view a list of valid payment types (or type the code if you know it) 

 Select CH and Click OK 

 Enter 300 as the amount and <Tab> 
 

 
 

 Enter the comment Subject Charges 

Note: The comment appears on the statement. 
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 Edit the Received from details to read 

 Title: Mrs 

 First Name: Maureen (Kent) 

 Address: 6 Smith Street, INGLEWOOD  6052 
 

 
 

 Click OK to save 
 

Note:  The receipt is allocated against billing items in reference order.  If specific billing 
items are to be paid, the applied columns must be edited and the amounts applied next to 
the relevant billing items. 

 

 Note: The ‘Received from’ field displays the name of the current fees biller for the student. 
If the payee is not the fees biller, the field should be edited to contain the name and address 
of the person paying the account. These details are saved with the receipt. 
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14.4.7 To Print a Receipt 

Activity: Printing a Receipt 

RM Billing > Students  

 Click on the Receipts tab 

 Highlight the receipt Balance of Subject Charges  

 Click Print   
 

 
 

 Choose Receipts > OK and OK to print the receipt to screen 

 View and close the Receipt 

 Click Print   

 Choose Record of Receipt Allocation > OK and OK to print the receipt to screen 
 

 View and close the Record of Receipt Allocation 
 

Note: The official document is the ‘Receipt’. This is what should be printed and given to the 
parent.  

The ‘Record of Receipt Allocation’ can also be printed if required. This lists the billing items 
to which the receipt is currently allocated. Note that the allocations for a receipt can change 
if paid billing items are reversed or adjusted or if unallocated credit is allocated. 
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14.4.8 Original/Draft/Copy text on Receipts 

To obtain an original receipt, the receipt must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Receipts printed directly to the printer for the first time will contain no additional text. 
Receipts viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
Receipts printed to the printer for the second or subsequent time will contain the text ‘COPY’. 
 
The above is an important audit consideration as there should only ever be one original receipt 
created. 
 

Activity: Review of Entering Individual Receipts 

RM Billing > Students  

 Right Click in the surname cell and type Partington and enter 
 
Enter the following receipts into RM Billing using the individual receipting method outlined above. 
 
1. Dean Partington has come to the front office to pay for the Camp charges. He has a cheque 

for $300.  Make sure you allocate the money to the camp. (You will need to change the 
automatic allocations). Print the receipt to screen. 

 

 
 
2. Donna Ravat has brought a cheque for $200 as part payment for her subject charges. Print 

the Record of Receipt Allocations to screen. 
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14.5 Reporting on Receipts 

Reports available for receipts include the Daily Banking Report and the Receipts Summary Report.  
The Daily Banking Report is useful in reconciling the daily takings. It separates the transactions by 
payment type (e.g. Cash and Cheque) and gives overall totals.  The Receipts Summary groups all 
receipt allocations by analysis code, budget code and GST Code. It is used for the manual input of 
transactions into RM Finance. 
 

Activity: Viewing Receipts Reports 

RM Billing > Receipts 

 Highlight the General Banking receipt batch 

 Choose For Selected > Print Daily Banking 
 

 

 
 

 This report can be used to check the calculations of your totals to be banked 

 Print a paper copy of the report and file it (This is a mandatory report) 

 View and close the Daily Banking Summary Choose  
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Print the Receipts Summary 
 

 For Selected > Print Receipts Summary 

 Click Yes to print the detailed summary (This is a mandatory report) 

 View and close the Receipts Summary  
 

 Choose For Selected > Print Receipts Summary 

 Click No to print totals only  
 

 
 
A portion of the report is displayed below 
 

 
 
This report is used when processing receipts from RM Billing into RM Finance.  This will be 
covered later in training. 
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15 Statements  

15.1 Producing Statements for Students 

In RM Billing an individual statement can be produced for each student.  Student statements can 
be accessed from two places: 
 

 Students > For Selected > Print Statement 

 Reports > Financial Reports > Statement – Students 
 

15.1.1 Printing a Statement from the Student List 

Activity: Print a Student Statement via the Students window 
 
Print a statement for Rhys Fitton 

RM Billing > Students 

 Highlight Rhys Fitton 

 Choose For Selected > Print Statement 
 

 
 

 The ‘From’ date will default to the first day of the current month. All transactions from this 
date onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement you are sending to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed 

 The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end 
date may be entered. Transactions dated after the ‘To’ date will not be included on the 
statement 

 The default message that you entered in the Billing Parameters section will be displayed. 
This can be edited at this point if required but the changes will be used for this statement run 
only and will not be saved down 

 Accept the default entries for the training course and click on OK 

 View and close the statement 
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Note: A summary table will be printed at the bottom of the student statement. This will 
categorise all amounts outstanding, (regardless of the dates entered for the date range), by 
billing year and category.  This method can also be used to print statements for multiple 
students.  Students can be selected by using the find tool or by sorting on column heading 
and then highlighting the required students. 

15.1.2 Print Statements for Outstanding Debtors 

Statements can be produced only for those students with outstanding debt. 
 

Activity: Producing Statements for Outstanding Debtors Only 

RM Billing > Students 

 Click on the Balance heading twice to bring those students with outstanding balances to the 
top of the list 

 Highlight the students with a balance > 0 

 Choose For Selected > Print Statement 

 View and close the statements 
 

 
Periodically schools may send out statements to follow up on outstanding student debt.   A record 
of students for whom statements have been sent should be saved to the  G drive in a designated 
folder saved within the Audit Reports folder  G:\Audit Reports\Student Statements. 
 

Activity: Print Student Statements 
 
We will print Statements for Year 11 students with outstanding balances. 

RM Billing > Students 

 Click on Student Find  

 Select the Year 11 students 

 Click on Find, Select and Yes 

 Click on the Balance Header to sort students by outstanding amounts 

 Highlight the students with outstanding amounts  

 Select to hide the unselected students   (Ashleigh Campbell has paid in full) 

 Click on the Name header to sort the students into alphabetical order 

 Click on   

 Select to print the list of students to screen 

Note: A list of families to whom statements have been sent must be printed. This list is to 
be signed by the Principal and the report filed. 
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 Highlight the students 

 Click For Selected > Print Statement 

 Change the From Date to 1 Jan 2019 
 

 
 

 Click on Ok 
 

 Select Report Destination  

 Click on Ok 
 
To Save the Report 

 Click on Save to  

 For Training select  Save to the Desktop.  
 

  
 

 Name the file  
 

 
 

 Click OK 

Note : At school users will navigate to G:Audit Reports/student statements 

Print the Statements 

 Click on  

 Select the required printer and click Ok.  In training we will not be able to print the statements 
to a printer 
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15.1.3 Printing a Statement from Reports 

Activity: Print a Student Statement via Reports 
 
Print a statement for all current Year 11 students. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Highlight Statement – Students 
 

 
 

 The Date range and the default message operate as described in the previous section 

 Click   

 Select Year Group 11 and click on Find 

 Select all the Year 11 students 

 Click Print and change the Report Destination back to Screen 

 View and close the statements 

 Close the Reports window 
 

 

15.2 Family Statements 

Family statements (i.e. one statement which lists transactions for all siblings in the family) cannot 
be produced in this version of RM Billing. 
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16 External Customers 
An External Customer may be anyone the school deals with who is not a student or a 
parent/guardian – i.e. companies or individuals outside of the school environment. 
 
External customers have their own section in RM Billing – the ‘Customers’ section on the side bar. 
Unlike students, the customer details are not drawn from the Integris datafile. All Customer Details 
need to be entered manually into RM Billing. 
 
The functionality in the Customers section is similar to that in the Students section. Double-clicking 
on a customer record or highlighting the customer and pressing enter will invoke the drill down 
facility and many of the same tabs are available. 
 
Customers are not linked to Timetabling (so there is no subject billing) and there are no bulk 
processes (such as bulk billing and bulk receipting) designed for customers. 

16.1.1 Creating External Customers 

Activity: Create External Customer 1 
 
The local theatre group, West Coast Theatre, is interested in hiring out the school hall for their 
after school rehearsals. The school has agreed that they are able to lease the hall in Term 1 for 
a total of $1045.00 (including GST), charging $550 for the first 5 weeks and $495 for the 
remainder of the term.   Set up the details for West Coast Theatre. 

RM Billing > Customers 

 Click Add Customer   

 Enter the details as shown below 
 

 
 

 Click OK to save 
 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 159 of 322 

© 2019 Civica Pty Ltd 

 

 

Note:  A BPAY Reference number is automatically produced for customers when the 
school has enabled BPAY in RM Billing > Parameters.  If this function is not selected, a 
BPay Reference number will not be created. 

 
 

Activity:  Create External Customer 2 
 
Oceanview Tennis Club has enquired about hiring the school’s tennis courts for four weeks 
interim coaching lessons while the district’s tennis club courts are being re turfed.  We have 
agreed to 3 afternoons per week at $80 (Inc GST) per session for which they will pay weekly in 
advance. Set up the details for Oceanview Tennis Club. 
 

 Click Add Customer   

 Enter the details as shown below 
 

 
 

 Click OK to save 
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16.2 Customer Billing 

Customers are billed in the same way as students – a Billing Items batch needs to be created. 
 

16.2.1 Create a Billing Items Batch 

Activity: Create a Billing Items Batch for West Coast Theatre 
 
Create a Billing Items batch for the Hall Hire as illustrated below. 

RM Billing > Billing Items 

 Click Add Item   

 Enter the description of West Coast Theatre – Hall Hire and click OK 

 Click Add Debit   

 Enter the comment 2019 Hall Hire Term 1 Weeks 1-5 <Tab> 

 Enter the amount 550 <Tab> 

 Enter the GST code of 1 <Tab> 

 <Tab> and select the Billing Code HIR01 

 Click OK 

 Repeat the steps above to add the second tied billing item 
 

 
 

 Click   Return to View 
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16.2.2 Create a Billing Items Batch 

Activity: Create a Billing Items Batch for Oceanview Tennis 
Club 
 
Create a Billing Items batch for the Hire of Tennis Courts as illustrated below. 

RM Billing > Billing Items 

 Click Add Item   

 Enter the description of Oceanview Tennis Club – Hire of Tennis Courts and click OK 

 Click Add Debit   

 Enter the comment 2019 Tennis Court Hire Week 1 <Tab> 

 Enter the amount 240 <Tab> 

 Enter the GST code of 1 <Tab> 

 <Tab> and select the Billing Code HIR01 

 Click OK 
 

 
 

 Close the Billing Items window 
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16.2.3 Bill the Customers Using the Batch 

Activity: Billing Customers 
 
Bill the Customer ‘West Coast Theatre’ using the Hall Hire batch. 

RM Billing > Customers 

 Double-click on West Coast Theatre 

 Select the Billing Items tab 

 Click   

 OK to the 2019 Billing Year 

 Choose the West Coast Theatre Hall Hire batch from the list displayed 
 

 
 

 Click OK 
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 Click on the Red Customer Name   

 The Oceanview Tennis Club will display 
 
Bill the customer ‘Oceanview Tennis Club’ for the hire of the tennis courts for one week using 
the Hire of Tennis Court batch 

RM Billing > Customers 

 Double-click on Oceanview Tennis Club 

 Select the Billing Items tab 

 Click   

 OK to the 2019 Billing Year 

 Choose the Hire of Tennis Courts batch from the list displayed 
 

 
 

 Click OK 
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16.3  Customer Invoices 

Whenever a customer is billed a tax invoice is automatically created.  
 

Activity: View a Tax Invoice 
 
View the Tax Invoice which has been automatically created for Oceanview Tennis Club 

RM Billing > Customers 

 Click on the Invoices tab 

 Highlight the Invoice which is listed 
 

 
 

 Click Print   

 View and close the tax invoice 
 
 
 

Notes: This tax invoice is fully compliant with government regulations. Billing Items may be 
edited before they are applied to a Customer record.  
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16.3.1 Open/Closed Invoices  

If an invoice has not been sent directly to the printer it is considered to be ‘open’.  This means that 
if more billing items are added to this customer they will be added to this open invoice.  Once the 
invoice is sent straight to the printer it is automatically closed.  If additional billing items are added 
to the customer once an invoice is closed a new invoice will be created for these items.   
 

16.3.2 Draft/Copy/Amended text 

To obtain an original invoice, the invoice must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Invoices printed directly to the printer for the first time will contain no additional text. They will also 
be ‘closed’ by printing them straight to the printer (see above). 
 
Invoices viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
 
Copies of invoices printed to the printer for the second or subsequent time will contain the text 
‘COPY’. 
 
Invoices may also contain the text ‘Amended’ followed by a date. If an invoice is amended (i.e. 
changes are made to the billing items attached to the invoice once it has been closed) then an 
amendment number will be attached to the original invoice number (e.g. 36-1). The invoice will 
contain the ‘Amended’ text and the date of amendment. It is possible for an invoice to be amended 
more than once. Invoices will be amended if the billing items attached to them are reversed, 
adjusted or discounted once the invoice is closed. 
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16.4  Receipting for Customers 

Individual receipts can be created for a particular customer. This is done via the Customers section 
by drilling down on the Customer record and going to the Receipts tab. 
 

Activity: Add a Customer Receipt 
 
Oceanview Tennis Club have  paid in advance for their first week of tennis court hire with a 
cheque for $240.  Process the payment for the Oceanview Tennis Club. 

RM Billing > Customers 

 Select the Receipts tab 

 Click Add Receipt   

 Press <Tab> in the Batch No field and select the General Banking Batch 

 Enter the payment type of CH or press <Tab> for a list 

 Accept the default date 

 Enter the amount of 240 

 Enter a Comment (e.g. Tennis Court Hire Week 1) 

 Check that the applied amount is correctly allocated in the lower window 
 

 
 

 Click OK 

 Highlight the receipt 

 Click Print   

 Select Receipts and OK and OK to print the receipt to screen 

 View and close the receipt 
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West Coast Theatre has also paid for the hall hire for weeks 1-5.  The money has been paid 
directly into the bank using EFTPOS via the schools on-site machine.  Print a copy of the receipt 
for West Coast Theatre. 

RM Billing > Customers 

 Click on the Red Customer Name to change to West Coast Theatre 

 Click Add Receipt   

 Press <Tab> in the Batch No field and select the Electronic Funds Transfer batch 

 Enter the payment type of EF or press <Tab> for a list 

 Accept the default date 

 Enter the amount of 550 

 Enter a Comment (e.g. Hall Hire Term 1 Weeks 1-5) 

 Check that the applied amount is correctly allocated in the lower window 
 

 
 

 Click OK 

 Highlight the receipt 

 Click Print   

 Select Receipts and OK and OK to print the receipt to screen 

 Click   Return to View 
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16.5  Customer Statements 

Statements for customers can be printed from the Reports section as follows. 
 

Activity: Print a Customer Statement 
 
Print a statement for West Coast Theatre and Oceanview Tennis Club 

RM Billing > Reports 

 Open the Financial Reports folder 

 Select the Statement – Customers report 

 The date range and the message operate as outlined in the student statement 

 Click Find Customer   
 

 

Note: The customer can be searched for using the customer name field and the search 
button. 

 Select both customers 

 Accept the default settings for the training course 

 Click Print and OK 

 View and close the Statement 

 Close the Reports window 
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Activity: Day 1 Review 
 
Write down the steps or path you would take to: 
 
1) Create a new billing code in RM Billing. 
 
 
 
 
2) Enter subject costs into RM Billing. 
 
 
 
 
3) Create a Charges and Contributions Template. 
 
 
 
 
 
 
4) Create subject billing items for students. 
 
 
 
 
 
 
5) Apply a Billing Item to a student. 
 
 
 
 
 
 
6) Add a discount to a billing item for a student. 
 
 
 
 
 
7) Add Bulk Receipts through 

 
a) The Billing Item 

 
 
 

b) A Receipts Batch 
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17 RM Billing & RM Finance Interface 
All receipts (except Government Subsidies) which are entered into RM Billing need to be 
transferred to RM Finance where the reconciliation will take place. If you follow the receipting 
processes outlined in these notes, then the reconciliation in RM Finance should be relatively 
straight forward. There are two ways in which the receipts can be transferred: 
 

 Manual input to RM Finance using summary reports produced from RM Billing 

 Automatic export to RM Finance using the inbuilt export routine 

Note:  For newly implementing schools, your Implementation Consultant will activate 
exporting for you.  For schools currently using RM Billing and manually updating RM 
Finance, please contact your SFC. 

17.1 Manual Input of Receipts to RM Finance 

The contents of the General Banking batch must be manually entered into RM Finance. This 
should be done when you are ready to finalise the banking and close off the batch – i.e. no 
further receipts should be input into this batch once this process has commenced. 
 

17.1.1 Print Daily Banking Summary and Transfer Information to the Batch Register 

Firstly the Daily Banking Summary must be printed and the information from this Daily Banking 
Summary written onto the Finance Batch Register. 
 

Activity: Transferring Totals from the Daily Banking Summary 
to the Finance Batch Register 

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Print Daily Banking > OK 

 View the printed Daily Banking Summary on the following page 
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 This report can be used to check the calculations of your totals to be banked 

 Print a paper copy of the report and file it 

 Fill out the Finance Batch register as outlined below: 
 

 
 

Note: Schools may enter a Billing batch type.  Eg GB General Banking, Cor Correction, EF 
Electronic Funds Transfer, REF Refund. 
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Print the Receipts Summary Report 

The Receipts Summary Report must be printed, as it used for manual input into RM Finance. 
 

Activity: Printing the Receipts Summary Report 

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Print Receipts Summary 

 Click OK to the Screen 

 Click on Yes to print the detailed summary 

 This report should be printed to the printer and filed for reference 
 

Note: The ‘Totals Only’ version of the Receipts Summary report is recommended for the 
manual input of data into RM Finance, however the detailed summary must be printed and 
filed for reference. 

17.1.2 Close the Batch in RM Billing 

The receipts batch must be manually closed to ensure that no more receipts are processed 
through it.  When a receipts batch is closed it’s because the banking has been finalised.  A new 
receipts batch can be opened with the same format and using the current date of opening (eg. 
General Banking 11.02.19) 
 

Activity: Manually Closing the Receipts Batch in RM Billing 

RM Billing > Receipts 

 Highlight the General Banking batch 

 Click For Selected > Close Batch 
 

 
 

 
 

 Click Yes 

 The Print Setup screen appears 

 Check your settings and click on OK 
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 Click No to get the Totals Only version of the report 

 Go to the printer and check that the report has printed successfully 
 

 
 

 If the report has not printed correctly click on ‘No’. Go back to the start of the ‘Close Batch’ 
process and repeat the steps listed 

 

 If the report has printed correctly click ‘Yes’ (ensure care is taken with the process of 
closing the batch and marking the transactions posted, as this cannot be reversed).  A 
working message may briefly appear. Then the batch is marked as closed, meaning that no 
further receipts can be placed in the batch 

 

  
 

 

17.1.3 Manually Enter Data into RM Finance 

It is not necessary to enter every single RM Billing receipt transaction into RM Finance. The actual 
transactional details will always be available within RM Billing. For each batch, it is necessary to 
enter an overall total for each budget/analysis/GST code grouping.  
 
The ‘Totals Only’ version of the Receipts summary report will be used to input the data into RM 
Finance. This report was printed when the batch was closed.   The following page shows a copy of 
the report. 
 
The report is broken up via the various billing codes.  The budget and analysis code is displayed 
for each billing code as is the total for that budget and analysis code.  Receipts which contain GST 
are separated from those which do not have GST. 
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Activity: Manually input Receipts Batches into RM Finance 
 
Manually enter the transactions into RM Finance as per the above report.  The transactions 
entered into RM Finance for this report would be as follows: 
 

Inc 
Source 

Reference Batch 
Ref 

Detail Budget Analysis Total Tax 
Code 

INC001 B00004 B00004 
Upper School 
Charges 

C1051 
 

C1050 
1300.00 0 

INC001 B00004 B00004 
School Camps 
 

C1182 C1180 
1350.00 0 

INC001 B00004 B00004 
School Camps 
 

C1182 C1180 
1350.00 1 

INC001 B00004 B00004 
Hire of Tennis 
Courts 

C1705 C1700 
240.00 1 

INC001 B00004 B00004 
School Year Book 
 

C1201 C1200 
40.00 0 

INC001 B00004 B00004 
Suspense Account 
 

N3199 N3100I 
300.00 8 

INC001 B00004 B00004 
Voluntary 
Contributions (7-10) 

C1001 C1000 
265.00 0 
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RM Finance 

 Log in to RM Finance as the Manager Corporate Services with the password of keys 
 

 
 
If not exporting, the totals for each Budget Account must be manually entered into RM Finance  
using the Receipts Summary Totals Only Report. 

Transactions > Income 

 
Step 1 – Enter the Totals for Budget Accounts 
 

 Type INC001 in the Income Source <Tab> 

 Type total 4845.00  in the Total <Tab> 

 <Tab> to accept the default date 

 Enter the Reference as B00004<Tab> 

 Enter the Batch Ref. as B00004<Tab> 

 Enter the detail as Upper School Charges <Tab> 

 Enter C1051 as the Budget code (can <Tab> to select this from a list ) <Tab> 

 Enter 1300 as the line total <Tab> 

 Type 0 as the tax code 
 

 
 

 <Tab> twice to drop the information into the All Income Lines section of the screen 
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 Continue entering the income transactions using the table below: 
 

 
 
 

Detail Budget Total Tax Code 

School Camps C1182 1350.00 0 

School Camps C1182 1350.00 1 

Hire of Tennis Courts C1705 240.00 1 

School Year Book C1201 40.00 0 

Billing Suspense N3199 300.00 8 

Voluntary Contributions C1001 265.00 0 

 
 

  
 

 View the All Income Lines section and make sure that the line total matches the total at the 
top of the Income window 

 Click  
 

 
 

 Click OK to select the Cheque Account 
 

 
 

 Click Yes to batch the transaction 
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Step 2 – Check the Batched Transactions Report 

 Click   

 Select the Batched Transactions Report  

 Tick Income and the Cheque Account 
 

 
 

 Click Print 
 

 Check the Batched Transactions Report against the Receipts Summary making sure that the 
correct budget codes, tax codes and amounts have been entered. 
 

A portion of the report is displayed below 
 

 
 View and Close the report 
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Step 3 – Edit the Batch if necessary 

Transactions > View/Post Batch > Income 

 Display batch B00004 

 To edit the batch highlight the line for B00004 

 Click Edit   

 Select the line to edit in the All Income Lines section 

 Edit the necessary field 

 <Tab> to clear the Edit selected Income Line section of the screen 

 Click  > Select the Cheque account > OK and Yes 
 
Step 4 – Post the Batch 

Transactions >View/ Post Batch 

 Click on Income 

 Enter B00004 as the Batch reference 
 

 Click Display    to display the batch 

 Click Select All   to change the No to a Yes and view the Total to post of $4845 
 

  
 

 Click   
 

 
 

 Click Yes 
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Step 5 – Check the result of posting the Billing Receipts batch (optional) 

Records > Budget Accounts 

 Click  
 

 Type C1182 in the Budget Account <enter> 
 

 Click on the magnifying glass to the right of the Balance Remaining  
 

 
 

 Select Full Budget Analysis > Print (Ensure the screen is selected) 
 

 
 
 

 Click OK  to print to the screen 

 Click Yes to print the Transactions for this period only 

 
 

  Yes to show the Transaction Descriptions on the report 

 
 

  Click OK  to set the printer to Landscape and then follow the prompts 
 

 
 

 View the Budget Analysis Report with the details entered from the Billing Receipts batch 

 Close the Report 

 Minimise RM Finance 
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Activity: Close the EFT Batch 

RM Billing > Receipts 

 Highlight the Electronic Funds Transfer receipts batch 

 For Selected > Print Daily Banking 

 Print the report and file it 
 

 
 
 
 

 Enter the details of the batch onto the Finance Batch Register and Close the report 
 

 

 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 183 of 322 

© 2019 Civica Pty Ltd 

 

 

 For Selected > Print Receipts Summary 

 Yes to print the detailed summary 
 

 Print and file the report 

 Close the receipts summary 
 

 For Selected > Close Batch 
 

 
 

 Click Yes 

 Select the correct printer > OK > No Totals Only 

 Check that the report has printed correctly 
 

 
 

 If the report has printed correctly click Yes otherwise click No and begin the process again 

 If the report has printed correctly, the Electronic Funds Transfer batch will now show that it is 
no longer open 
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 Close the receipts summary report 
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Step 1 – Enter the Totals for each Budget and Analysis Code into the Income screen 
 

 Maximise RM Finance 
 

 Transactions > Income 
 

 

 Enter the Income Source of INC001 <Tab> 

 <Tab> to accept the default date 

 Enter the total of 1490<Tab> 

 Enter the Reference of B00005 <Tab> 

 Enter the Batch Ref. of B00005<Tab> 

 Enter the detail Hire of Facilities – Hall Hire <Tab> 

 Enter the Budget Code C1705 <Tab> 

 Enter the Line total 550 <Tab> 

 Enter the Tax code 1  
 

 
 

 <Tab> twice 
 

 
 

 Continue entering information for the Voluntary Contributions  
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 <Tab> to drop the line to the lower window 
 

 
 

 Check that the line total mataches the total in the top Income window 
 

 Click   

 Click OK to the Cheque Account 

 Click Yes to batch the transaction 
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Step 2 – Check the Batched Transactions Report 
 

 In the Transactions menu click   
 

 Select the Batched Transactions report 
 

 Include Income Transaction Types and select the Cheque Account 
 

 Click Print 
 

 

 
 Check the batched transactions report against the receipts summary making sure that the 

correct budget and analysis codes have been entered and the correct GST codes used 
 

 Close the batched transactions report 
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Step 3 – Edit the Batch if necessary 

Transactions > View/ Post Batch > Income 

 Display batch B00005 

 Highlight batch B00005 and click Edit   

 Select the line that needs editing in the All Income Lines section of the screen 

 Edit the required field 

 <Tab> to clear the Edit Selected Income Lines section of the screen 

 Click   >OK 
 
Step 4 – Post the Batch 

Transactions > View/Post Batch > Income 

 

 Enter B00005  Display   
 

 
 

 Click Select All   
 

 
 

 Click   
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 Click Yes to post the selected items 
 

 
 

 Close RM Finance 
 

 Click Yes to Quit and NO to the Safe Backup message 
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18  Follow-up of Unpaid Debts 
There are a number of reports within the system which can be used to assist with the follow up of 
unpaid debts. 

18.1  Outstanding Billing Items 

18.1.1 Printing Outstanding Items from the Billing Items batch 

Outstanding billing items can also be identified by looking at the billing items batch. 
 

Activity: Print List of Outstanding Billing Items 
 
Print a list of outstanding billing items in the School Year Book batch. 

RM Billing > Billing Items 

 Double-click on the School Year Book batch 

 Click on the Batch Billing Items tab 

 Click Show Outstanding Amounts   

 Click on the Filter Icon  

 Select Balance > 0.00  
 

 
 

 Click OK 
 
All the Items with a Balance > $0 will be highlighted 
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 Click Print Selected   

 View and close the report 

 Close the Billing Items window 
 

Note: This report will always list the individual billing items. If you have multiple Tied Billing 
Items, the Transaction Summary report (as detailed below) allows the overall totals per 
student to be displayed. 
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18.1.2 Transaction Summary Report 

Activity: Print the Transaction Summary Report for a Batch 
 
Print a report which lists all students who have not paid in full for the Camp. 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Click on Transaction Summary 

 Click New Query  

 Use the find tool to select all the Year 11 students (a form group can be selected if required) 

 Place a tick in the Student Totals Only box 

 Delete the default dates 

 Click on the Billing Options tab 

 Type an asterisk (*) in the Billing Item Batch field and press <Tab> 

 Select the batch for the Year 11 Camp 

 Place a tick in the Billing Item Balance box 

 Click on the equals sign (=) and select the (>) operator from the list 
 

 
 

 Click Print 

 View the printed report detailed on the next page 

 Close the report 
 

 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 193 of 322 

© 2019 Civica Pty Ltd 

 

 

 

 
 

 To see the three billing items for each student uncheck the Student Totals Only checkbox 

 Click Print 
 

 
 

 View and close the report 

 Close the reports window 
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18.1.3 Summary Aged Debt Lists 

This report is another useful way of identifying outstanding debtors. This report will display a list of 
Students or Customers (there is a separate report for each) who have an outstanding balance 
greater than zero. The amounts owing are classified into current, 30, 60 and 90+ day categories.   
 

Activity: Print a Summary Aged Debt List 
 
Print a Summary Aged Debt List for Students. 

RM Billing > Reports 

 Open the Financial Reports folder 

 Click on Summary Aged Debt List – Students 

 Click New Query  

 Use the find tool to select the Year 11 students on the current roll 

 Click Print 

 View and close the report  
 

 
 

 Close the reports window 
 

Note: A Summary Aged Debt List for Customers can also be produced from the same 
section using the Customer report 
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19 Notes 
It may be useful at times to record certain information relating to students or parents regarding 
payment of accounts.  Attached to each student record is a ‘Notes’ tab that can be used for this 
purpose. 
 

19.1.1 Entering Notes for Students 

Activity:  Enter Student Notes 
 
Record the following notes for each student listed below. 
 

Name Subject Details 

Bradley Uifelean Charges Mrs Uifelean rang to say she will pay after she 
receives her tax refund. 

Michael Fulter Charges Mr Fulter rang to say that he will pay for the camp by 
the end of next week.  

Jonathon Depete Contributions Mr Depete rang to say that he will not pay for the 
remainder of the costs as they are voluntary. 

Bradley Uifelean Charges-Camp Mrs Uifelean rang to say that Bradley’s grandparents 
will be paying for the camp. 

RM Billing > Students 

 Double-click on Bradley Uifelean 

 Click on the Notes tab 

 Click Add a note   

 <Tab> to accept today’s date 

 Type Charges as the subject 

 Enter the details from the above table in the lower window 

 Click OK to save 

 Highlight the note 

 Click Edit   

 Add to the details ‘Tax refund expected later this term’ 

 Click OK 

 Right click on the Surname Field and enter next name 

 Continue adding notes for the students in the table above 
 
To View an individual’s notes, click on the Printer when in the Notes window 

 In Bradley Uifelean’s window click Print   

 View and close the printed notes list 

 Click Return to View   
 

Note: Notes can be deleted by clicking the  
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 Viewing Student Notes 

Student Notes can be viewed and printed from the Student window.  An option is available to 
select a date range if searching for notes outside of the current date or to enquire as to when the 
notes were originally recorded. 
 

Activity: Print Student Notes 
 
RM Billing > Students 
 

 Click on the Notes header twice to bring all the students with notes to the top of the list 
 

 
 

 Highlight all the students with Notes 

 Choose For Selected and Print Notes 
 

 
 

 
 

 Enter a date range for the current month 

 Click OK 

 Repeat without entering a date range 

 Click OK and all notes are displayed 

 View the Notes Report and close 
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20 Exporting to RM Finance 
 
Exporting to RM Finance allows schools to export their Billing Receipts into RM Finance.  Once the 
Export function is enabled, it cannot be disabled, therefore this function should not be turned on 
until after consultation with the school’s Senior Finance Consultant. 
 
The following steps must be completed in conjunction with the Financial Services and Support 
Directorate before the Export Function is enabled: 
: 

 All RM Billing receipts batches must be closed and all transactions posted to RM Finance. 
 

 The EPA Billing receipts batches must be closed and reconciled to the Gateway summary 
 

 All receipt batches must balance to the banking 
 

 The ‘Print Re-Allocation Transaction Report’ must be printed directly to the printer for 
transactions to be marked as posted in RM Billing.  This report is then used to enter the data 
into RM Finance  

 

 The RM Billing unallocated credit listing and the RM Finance N3199 Billing Suspense Account 
must balance. 

 
Once confirmed  by the School’s Senior Finance Consultant, the Export to RM Finance function  
may be turned on 

IMPORTANT:   

Once the Export to RM Finance in enabled, it cannot be disabled. 
Secondary schools MUST NOT turn on the Export function until after 

consultation with the school’s Senior Finance Consultant. 

All receipts (except Government Subsidies) which are entered into RM Billing need to be 
processed in RM Finance where the reconciliation will take place.  Once the Export function has 
been enabled, the manual input of receipts batches into RM Finance is no longer required.  Once 
the banking has been finalised, the Export to RM Finance utility will transfer the contents of the 
selected batches into RM Finance.  As the batch is exported, it is automatically closed, so new 
banking batches would need to be created to hold further takings. 
 
The same first steps as carried out for the manual input need to be carried out for the automatic 
export 
 

 Print the Daily Banking Summary 
 

 Print the Receipts Summary (Detailed Report) 
 

Once the Daily Banking and Receipts Detailed Summary have been printed, the Export to Finance 
procedure can be initiated. 
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20.1 Re-Allocation Report 

Before we can enable Export to RM Finance, there are transactions (receipts and re-allocations) 
created when importing and allocating the Clothing Allowance batch that need to be marked as 
posted. The software will not allow the Export Function to be turned on unless these transactions 
have been finalised. 
 

Activity: Run Re-Allocation Report 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Highlight Print Re-allocation Transactions 
 

 
 

 Click Print 
 

 
 
There should be no re-allocation items to print. 
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Note: When running this report at school, it must be sent directly to the Printer to mark 
transactions as Posted. 

 
 

 Click OK 

 Click Yes to the Print Re-allocation Transactions message 
 

 
 

 Click OK to the final message 
 

 
 
This process produces two reports, a Detailed Report and a Totals Only Report (See samples 
on the next page). These would normally be used to enter the necessary transactions into RM 
Finance.  

Note: If this report is not sent directly to a printer, the following message will display. 
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Sample Re-allocation Reports 
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20.2  Automatic Export of Receipts to RM Finance 

Schools may turn on the Export to RM Finance after consultation with the school’s Senior Finance 
Consultant. 
 

Activity:  Enable Export to RM Finance 
 
We have now received permission from the school’s Senior Finance Consultant to turn on the 
Export to RM Finance function. 
 
RM Billing > Parameters > Billing Parameters 
 

 Click Change Parameters 
 

 
 

 Place a tick in the Enable Export to RM Finance check box 
 

 
 
 

 Click OK to save 
 

 
 

 Click Yes to enable the link 

 Close the Parameters window 

 Close the Billing Parameters window 
 

 

WARNING   

Once the ‘Enable Export to RM Finance’ function has been turned on, it 
cannot be disabled.  This function must not be turned on until you are 

sure you are ready to begin exporting automatically and permission has 
been granted by the school’s Senior Finance Consultant. 
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Notes:  When attempting to enable the link to RM Finance, the following message may be 
displayed 

 

To correct the error check the following: 

All Receipt Batches have been closed and transactions marked as posted, as outlined in these 
notes. 

All Re-allocation transactions have been printed directly to the printer and marked as posted, as 
outlined in these notes 

Close RM Finance and re open it. 
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21 Receipting after Export to RM Finance enabled 
 
There is no change to the receipting process once the Export to RM Finance is enabled. If the 
banking batches have been closed, new batches must be opened to hold any further receipts. 
 

Activity:  Open new Receipt Batch 
 
As the General Banking batch was closed and the receipts entered into RM Finance, a new 
General Banking batch must be opened to hold any further receipts that are received. 
 
Create the following  receipt batch using today’s date: 
 

 General Banking dd.mm.yy 

RM Billing > Receipts 

 Click Add  

 Enter the description and today’s date 
 

 
 

 Click OK to save 
 

Note:  An Electronic Funds Transfer batch may also need to be created, but for training 
purposes today, we will only open a General Banking batch 
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21.1  Enter Receipts after RM Export enabled 

Activity:  Entering Receipts 
 
The following students have all paid in full for their camp charges. They have paid by cheque. 
Enter these receipts in bulk via the Batch Billing Items batch 
 

Name Payment Type Amount Paid 
 

Jenny Black CH 300 

Josh Johnston CH 300 

Total Amount Paid 600 

 
 
RM  Billing > Billing Items 
 

 Double click on the Year 11 Camp batch 

 Click on the Batch Billing Items tab 

 Click   

 Click on the Student/Cust column heading to sort the list 

 Highlight all three billing items for the above students  
 

  
 

Note: The Selected Totals Amount should match the total combined amount being paid. 
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 Click Add Receipts for the selected billing items   

 Enter the General Banking receipts batch or press <Tab> for a list   

 Type in the total amount for all students of 600 (this is the selected total) 

 Enter the payment type of Cheque or press <Tab> for a list 

 Enter a comment 
 

 
 

 Click OK 
 

 
 

 Click Yes 
 

 
 

 Choose Receipts 

 Click OK and OK to print to screen 

 View and close the receipts 
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Activity:  Review of Entering Receipts via the Billing Items 
Batch 
 
Use the same method to enter receipts for these students who have paid for their School Year 
Book by Cash. Print the receipts to the screen. 
 
 

Name Payment Type Amount Paid 
 

Amber Luong Cash 20 

Blake McLaren Cash 20 

Mitchell Melville Cash 20 

Total Amount Paid 60 
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21.2 Export to RM Finance 

The latest Receipts Batch can now be exported to RM Finance. RM Finance should be closed 
before exporting batches. 
 

Activity: 

RM Billing > Receipts 

 Highlight the General Banking Batch 

 Go to For Selected > Print Daily Banking 
 

 
 

 Add to the Batch Register 
 

 
 

 Go to For Selected > Print Receipts Summary 

 Print the Detailed Receipts Summary 
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RM Billing > Utilities 

 Double Click on Export to RM Finance 
 

 
 

 Click Yes to the message 
 

 
 

 Highlight the General Banking batch and click OK 
 

 
 

 Click OK to the Printer  

 Click OK to Export Complete 
 

 
 

Note: The Export process will automatically close the Receipts Batch. 
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The Batch Export Summary will be sent directly to the Printer. Exports Summaries can be Re-
Printed from Reports if required. 

RM Billing > Reports 

 Open the Audit Reports folder 

 Highlight the Re-print Receipts Batch Export Summary 
 

 
 

 Highlight the Export Summary and click Print 

 Click OK to send the report to the screen 
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Batch Receipt Export Summary Report 

This report will print automatically when the Export is processed. It must be printed and signed 
by the Principal as well as all Daily Banking Summary Reports and Detailed Receipt Summary 
Reports for each batch. 
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21.3 Update the Exported Batch in RM Finance 

The exported Receipts batch can now be checked and updated in RM Finance.  
 

Activity 

RM Finance > Transactions 

 Open RM Finance 

 Log in as Manager Corporate Services and Keys 
 

 
 

 Click on Reports on the Transactions Menu   
 

 Select Batched Transactions and Income 
 

 
 

 Click Print 
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 View and close the Batched Transaction Report 

 

 
Post the Batch 
 

 Click View/Post Batch on the Transactions Menu 

 Select Income 

 Enter B00006 in the Batch Ref 

 Click Display  
 

 
 

 Click on  
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 Click   
 

 
 

 Click Yes to post the amounts 
 

 Close RM Finance 
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22 Correcting Errors/Making Adjustments 
 
At times it may be necessary to correct an error made when entering a billing item or a receipt. 
Alternatively it may be necessary to make some type of an adjustment to a billing item or a receipt 
due to a change in circumstances. 
 
The table below outlines the different adjustment options which are available for billing items and 
receipts.  
 

Billing Items Receipts 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the billing item.  

 Used to correct an error 
(billing item should not have 
been created) 

 Used when a student should 
no longer be charged for an 
item (e.g. billed for Camp but 
now not going) 

Reversal This will create an opposite 
(reversal) transaction thereby 
‘cancelling out’ the receipt. 
 

 Used to correct an error 

 Used for cheques that are not 
cleared 

 Used for EFTPOS payments 
that have failed 

 
(Note that Billing item balances will 
be reinstated.) 
 

Adjustment This will create an adjustment 
transaction for the adjustment 
amount entered. This effectively 
reduces the amount of the billing 
item by the adjustment amount.  
 

 Mid Term Enrolments 

 Subject changes when billing 
for  a completed portion 
 

Note: An alternative method 
could be to reverse the item and 
then add a new billing item for a 
lower amount.   

Refund Used to refund amounts that have 
already been paid. 
 

 Used when money needs to be 
returned (refunded) to the parent 
or customer 

 
The associated billing items will be 
adjusted automatically so that the 
parent no longer owes the money. 

Write-Off This will create an opposite 
write-off transaction to negate 
the amount still owing on the 
billing item thereby ‘cancelling 
out’ the billing item. 
 

 Used at the end of the year 
to write-off debts that will not 
be recovered (in accordance 
with the Department’s write-
off policy) 

Note: The write-off procedure will be covered at the end of this training course. 
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22.1 Transaction References and Reasons 

22.1.1   Reasons 

If a transaction has been modified in some way (i.e. discounted, reversed, adjusted, written off or 
cancelled) then the reason field will begin with standard system-generated text (as shown below) 
followed by the reason entered by the operator. 
 
Types (for Billing Items). Valid Types for Billing Items are DR (Debit), RV (Reversal), AD 
(Adjustment) 
 
For Billing Items and their related transactions, reasons will begin with the following standard text. 
 

 
 
Type (for Receipts).  The transaction/payment type.  Valid types for receipt related transactions 
are – All Valid Payment Types - RF (Refund) and RV (reversal). 
 
For Receipts and their related transactions, reasons will begin with the following standard text. 
 

 
 

22.1.2  Reference Number 

When a billing item is entered into RM Billing, a reference number is automatically applied to the 
billing item.  In the table below, the 3 reference number items apply to the tied camp billing items. 

 
 
When a billing item is reversed, it is reflected in two lines. 
 

  
 
In the first line, the original transaction (1426) has a status of R: (Reversed), followed by a 
corresponding reference number 1429, showing that a reversal has taken place. The Reversal 
Transaction (1429) is displaying a status of V: 1426, which is a cross reference to the original 
transaction reference number.  This cross reference is particularly useful if there are multiple 
reversals, as it enables the user to match the original billing item to the reversed billing item using 
the transaction reference number. 
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23 Billing Item Reversals  

23.1 Billing Item Reversals via Student Records 

A billing item can be reversed if it has been entered in error, or if the student should no longer be 
charged for that item. 
 

Activity: Reverse a Billing Item 
 
All the Year 11 students have been billed for the camp. We have now received notification that 
Donna Ravat is unable to attend as she has broken her arm.  As she should no longer be 
charged for the camp, all of her camp-related billing items will need to be reversed. 

RM Billing > Students 

 Double-click on Donna Ravat 

 Click on the Billing Items tab 

 Highlight the first Camp billing item 
 

 
 

 Click Reversal   
 

 
 

 Click Yes 

 Enter the current month, date and reason (e.g. ‘ March 2019 - Not attending due to broken 
arm’) 
 

 
 

 Highlight the reason and <Ctrl> + C to copy the reason for use in the next reversals 

 Click OK 
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 A reversal transaction is created and both transactions now have a status and a reason 
 

 Repeat the above process to reverse the second and third camp billing items for Donna 
Ravat using <Ctrl> + V to paste the reason 

 

 
 

 Keep this window open 
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23.2  Timetabled Subject Changes 

Once the actual billing items have been created for Timetabled Subjects (via Utilities > Create 
Subject Billing Items) for a student, any subject changes made after that point in time will need to 
be reflected in RM Billing. 
 
The process for handling timetable changes in RM Billing involves: 
 

 Reversing the old subject billing item 

 Adding the new subject billing item 

Note: To change the subject preferences is the task of the Timetabler at your school. 
However, for the purposes of this training course we will need to change the subject 
preferences ourselves. 

Activity: Updating Subject Changes 
 
Several of our students have changed Subjects. We will make the changes to their Timetable 
first and then review their Billing information. 
 

Student Subject Change (From) Subject Change (To) 

Sean Guthrie Human Biology ATAR 11 
(AEHBY_2)) 

Earth and Environmental Science 
General 12 (GTEES_1)_ 

Ashleigh Campbell Human Biology ATAR 11 
(AEHBY_2)) 

Earth and Environmental Science 
General 12 (GTEES 1)_ 

David Maroney Modern History General 11 
(GEHIM_1) 

Geography ATAR 11 (AEGEO 1) 

 
 
Change the subjects for the students in Timetabling 

Timetabling > Student Course 

 Ensure 2019 is showing in the drop down list   
 

 Search for Sean Guthrie  

 Select the Grid tab under the Student’s Name 

 Right click on Human Biology ATAR 11 (AEHBY_2) 

 Choose Move Student 
 

 
 

 Select Earth and Environmental Science General 12 (GTEES_1) and OK 
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 Select the Preferences tab 

 Highlight his preference for Human Biology ATAR 11 in red 

 Click Delete   

 Click Yes 

 Click View/Print Course Change History   
 

 

Note:  At school this report should be given to the person who will be making subject 
changes in the RM Billing module as Billing Items do not change automatically. 

 Repeat these Steps for: 
 
Ashleigh Campbell- Human Biology ATAR 11 (AEHBY_2) to  Earth and Environmental Science 
General 12 (GTEES 1)_) (Delete Human Biology ATAR 11 from her Preferences tab) 
David Maroney- Modern History General 11 (GEHIM_1)) to Geography ATAR 11 (AEGEO 1) 
(Delete Modern History General 11 (GEHIM_ 1 from his Preferences tab) 
 

 Close the Student Course Maintenance window 
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23.2.1 Timetabled Subjects and Subject Billing Items Reports 

To assist in the management of student billing, users are able to produce reports which will 
compare a student’s subject listing with their billing items.  This allows users to easily identify 
subjects for which the student has not been billed or existing billing items for subjects which the 
student is no longer enrolled. 
 

Activity: Print Timetable Subjects and Billing Items Report 
 
Changes to students’ subject selections in Timetabling, has resulted in subjects with no billing 
items and billing items with no subject.  We are able to generate a report which will identify such 
changes and assist in the management of student billing.  

RM Billing > Reports >Transactional Reports >Timetabled Subjects and Billing Items  

 Click on New Query 

 Select Year 11 and click Find 

 Highlight Ashleigh Campbell, Sean Guthrie and David Maroney 
 

 
 

 Click Select and Yes to select the three students 
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 Ensure Both is selected 
 

  
 

 Click on Print 

 View the Report (see next page) 
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 Close the Report 
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23.2.2 Reversing Subject Billing Items 

Activity: View Subjects List 

RM Billing > Students 

 Double click Sean Guthrie 

 Select the Subjects tab 

 View the automatically updated subjects 
 

 
 
The subject billing item for Human Biology ATAR 11 must be reversed and the new subject 
billing item for Earth and Environmental Science General 12 must be added  for Sean Guthrie. 
 

 Select the Billing Items tab 

 Highlight the Human Biology ATAR 11 billing item 

 Click Reversal 
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 Answer ‘Yes’ to the message 

 Enter the month, year and reason (e.g. Month 2019 – Moved to Earth and Environmental 
Science General 12) 

 

 
 

 Click on OK 

 Sort by Reason 

 View the reversed billing item 
 
 

 

23.2.3 Adding New Subject Billing Items 

Activity:  Add Subject Billing Item 
 
Add the subject billing item for Earth and Environmental Science General 12 to Sean Guthrie. 
 

 Click   

 Choose Add Subject Billing Item 
 

 
 

 Click OK 

 Click OK to Billing Year 2019  
 

 
 

 Highlight Earth and Environmental Science General 12 in the list of subjects 
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 Click OK and view the newly created subject billing item 
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 Click  to view only items with an outstanding balance 
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23.3 Reversing Subject Billing Items which have been Receipted 

Activity: Reverse Subject Billing Item 
 
Ashleigh Campbell has already paid for her subject costs.  She has also changed her subject 
choice from - Human Biology ATAR 11 (AEHBY_1) to Earth and Environmental Science General 
12(GTEES_1) 

RM Billing > Students 

 Right click on Guthrie and type Campbell <Enter>  

 Select the Receipts tab 

 Click on the receipt for Balance of  the account 

 Check that Human Biology ATAR 11  has been receipted 
 
 

 Click on the Billing Items tab 

 Highlight Human Biology ATAR 11   
 

 Click   

 Click Yes 

 Enter the month, year and  reason for the Reversal and Click OK 
 

 
 

 Check the Unallocated Credit amount for Ashleigh 
 

 
 
This can be allocated once the new Subject Billing Item is added. 
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Activity: Add the Subject Billing Item 
 

 Click  

 Select Add Subject Billing Item 
 

 
 

  Click OK 
 

 
 

 Click OK to the Billing Year of 2019 

 Select Earth and Environmental Science General 12 
 

 
 

 Click OK 

 Highlight the Earth and Environmental Science General 12 billing item in the list 
 

 
 

 Click  Enter 50.00 in the amount to allocate and click OK 
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23.4 Reversing Subject Billing Items paid via Government Subsidy  

At times a student may have already paid for a subject or the subject may have been paid for by a 
government subsidy.  It may be necessary to reverse this billing item and create a new billing item 
for a new subject.  In this instance the receipted amount will become unallocated credit and must 
be manually allocated to a new billing item. 
 

Activity: Reverse Subject Billing Item 
 
David Maroney’s subject charge for GEHIM_1 Modern History General 11 has been met by the 
Education Program Allowance. He has changed his subject choice to Geography ATAR 11 
(AEGEO_1) 

RM Billing > Students 

 Right click in the Red Surname field, type Maroney and <Enter> 

 Select the Receipts tab 

 Click on the receipt for the $235 Imported Education Program Allowance  

 View that GEHIM_1 Modern History General 11 has been receipted 
 

 Select the Billing Items tab 

 Highlight the GEHIM_1 Modern History General 11 Billing Item 

 Click  
 

 
 

 Click Yes 
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Type the month, year and reason for reversal eg.  Current month 2019 - Moved to Geography 
ATAR 11 

 

 Click OK 
 

 
 

 View the unallocated credit of $50.00 
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23.4.1 Unallocated Credit Report -Government Subsidy 

Any payment which has not been allocated against a billing item will become unallocated credit.   
 

Activity: View the Unallocated Credit Listing Report 

RM Billing > Reports > Financial Reports > Unallocated Credit Listing 

 

 
 

 Click on Print to view the Unallocated Credit Listing 
 

 

Note: An asterisk against any student indicates that a portion or all of this unallocated 
credit is a Government Subsidy. 
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23.4.2 Allocate GV Credit 

David Maroney can have the Unallocated GV Credit allocated to his new Geography subject once 
the Subject Billing Item has been added. 
 

Activity: Allocate GV Credit 

RM Billing > Students 

 Double click on David Maroney 

 Select the Billing Items tab 

 Click  

 Select Add Subject Billing Item > OK 

 Click OK to the Billing Year of 2019 

 Select ( AEGEO) Geography ATAR 11 and click OK 
 

 
 

 Highlight the Select ( AEGEO) Geography ATAR 11 Billing Item 

 Click   

 Enter the Amount to Allocate $50.00 
 

 
 

 Click OK 

 Click  
 

 Click on the Receipts Tab 

 Highlight the $235 Education Program Allowance Receipt and view the change in the 
allocation of the receipt 
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23.4.3 Printing Updated Statements and Reminder Notices for the Students 

Activity: Print Reminder Unpaid Billing Items Report 
 
Print an updated Statement and a Reminder of Unpaid Billing Items report for Sean Guthrie, 
Ashleigh Campbell and David Maroney. 

Reports > Financial Reports > Statement-Students 

 Click on New Query 

 Select Year 11 and click Find 

 Highlight the three students 
 

 
 

 Click Select and Yes 

 Click Print and OK to send to the screen 

 View and Close the Statements 
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Reports > Financial Reports > Reminder Unpaid Billing Items-Students 

 Click New Query  

 Find the same three students 
 

 
 

 Click Print and OK to send to the screen 

 View and close the Report (see sample next page) 

Note: Where a student has no Billing Items that have an outstanding balance to pay, a 
report will not be produced. 
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Note: Reversed and Reversal Transactions, adjustment transactions, as well as any other 
items that have been paid in full, do not appear on this Reminder Notice 
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23.5 Bulk Reversals via Billing Item Batch 

Activity: Bulk Reversals via Billing Item Batch 
 
We have been advised that due to unforeseen circumstances the Outdoor Education course has 
been discontinued. We will reverse the Billing Items for the Outdoor Education course using the 
Bulk Reversal function available within the Billing Item Batch. 

RM Billing > Billing Items 

 Double click on the Subjects Batch 

 Click on the Batch Billing Items tab 

 Click on    

 Highlight all the transaction lines for Year 11 GEOED-Outdoor Education General 11 
     (Hint: Click on the Year header) 

 

  

 Click   Reverse the selected billing items 
 

 
 

 Click Yes to the Message 
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 Enter a themonth, year and reason ‘Month 2019 - Course discontinued’ 
 

 
 

 Click OK 
 

Note: Reversing Items in bulk in this way may result in the creation of Unallocated Credit 
for some or multiple students if Billing Items have been paid. This should be reviewed 
using the Unallocated Credit Listing Report. 

 

Important: Transactions which have been Reversed  (R) or are the 
Reversal Transaction (V) cannot be reversed. Transactions which have 

been Adjusted (A) or are the Adjustment Transaction (T) cannot be 
reversed.  Discounted transactions cannot be reversed unless the 

discount is removed. 
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23.6 Billing Item Adjustments 

An adjustment can be used to reduce a billing item amount.   
 

Activity: Adjust a Billing Item 
 
We have received notification that Julie Pilter will be providing her own transport to the camp 
(one way only). The school has agreed to charge only half the transport cost for the camp.  

RM Billing > Students 

 Start Typing Pilter to locate Julie Pilter’s record 

 Open her record 

 Select the Billing Items tab 

 Highlight the Camp Transport billing item 
 

 Click   
 

 
 

 Click Yes 

 Enter half the amount of 25 into the ‘Adjust down by’ field 

 Enter the month, year and  reason (e.g. ‘Month 2019 - Providing own transport one way’)  
 

 
 

 Click OK 

 Sort by Reason 

 View the adjustment in the billing items list 

 Click  to display the adjusted Billing Item 

 Close the student window 
 

Note: An alternative way to achieve the above would be to apply a 50% discount to the 
Camp Transport billing item. 
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24  Receipt Reversals 
A receipt can be reversed for a number of reasons. If the original batch the receipt was processed 
into has been closed, then an alternative batch must be created to either hold the receipt or pass 
the receipt through to another record.  If a receipt is to be refunded and the original batch has been 
closed, then a Refunds batch must be created to hold the reversed receipt. 
 

The Corrections Batch 

A Corrections batch would be created if the original batch the receipt was processed into has been 
closed and a receipt reversal is to be performed.  This could be because of user error resulting in a 
receipt having to be reversed or perhaps a cheque has been dishonoured by the bank, or a receipt 
has been applied against a wrong student record and therefore must be reversed and applied to 
the correct student. 
 

The Refunds Batch 

A Refunds batch would be created if money which has been paid, needs to be returned (refunded) 
to a parent/guardian.  Refund batches must be identified according to the type of refund  eg: EFT, 
System Generated Cheques or Manual written cheques.  If processing EFT refunds, the batch 
would be named Refunds – EFT dd/mm/yy etc. 
 
Unlike a General Banking batch or an EFT batch which may stay open until the banking is ready to 
be finalised, both the Corrections and Refunds batches are closed as soon as the Correction or 
Refunds have been completed. 
 

Non Exporting Schools 

Schools which are not exporting to RM Finance may write manual cheques or produce system 
generated cheques which can be created when the expenditure transaction is entered into RM 
Finance. 
 

Exporting Schools 

Schools which are exporting to RM Finance have the option of refunding through a Manual 
Cheque, a System Generated Cheque or through EFT.  This functionality is only available for 
Students at this time and not for Customer refunds.  Customer refunds must be made through a 
manual written cheque. 
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24.1 Refund Batches 

A refunds batch would be created if money which has been paid, needed to be returned (refunded) 
to a parent/guardian. 
 

Activity:  Create Refunds Batches 
 
Mrs Lornab, Jessica’s mother, has requested a refund of the $100 due to the reversal of the 
Outdoor Education course.  We have also been advised that Jillian Sorrell is unable to attend the 
Year 11 camp and West Coast Theatre has informed us the hall is unsuitable and have 
requested a refund.   
 

 Create 3 Refunds batches for the following: 
 

o Refunds-Manual Cheque (WCT) dd/mm/yy 
o Refunds-System Cheque (J Lornab)) dd/mm/yy 
o Refunds-EFT (J. Sorrell) dd/mm/yy 

RM Billing > Receipts 

 Click Add Item   
 

 
 

 Click OK 
 

 Click Add Item   
 

 
 

 Click OK 
 

 Click Add Item   
 
 

 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 242 of 322 

© 2019 Civica Pty Ltd 

 

 

 
 

 
 

 Click OK 
 

 Record the numbers on the Finance Batch Register 

 Close the Receipts window 
 

 

Activity: Create a Correction Batch 
 
A payment of $235.00 was incorrectly processed against the billing items for Emily Gold.  The 
receipt should have been processed against Kea Guester.  A Corrections batch must be opened 
to process the recipt from Emily Gold to Kea Guester. 
 
Create the following receipt batch using today’s date: 
 

 Corrections  dd.mm.yy 

RM Billing > Receipts 

 Add Item   

 Type Corrections and Today’s date 

 

 
 

 Click OK 
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24.2  Receipt Reversal into the Corrections batch 

Activity: Reverse a Receipt 
 
A payment of $235.00 was incorrectly processed against the billing items for Emily Gold.  The 
receipt should have been processed against Kea Guester.  The receipt will be reversed from 
Emily Gold’s record and re-entered in Kea Guester. 

RM Billing > Students 

 Double-click Emily Gold 

 Select the Receipts  tab 

 Highlight the $235 receipt for Voluntary Contributions 

 Click   
 

 
 

 Click Yes 

 Enter a reason for the reversal (e.g. ‘Error – should have been applied to Kea Guester) 
 

 
 

 Click OK 

 Select the Corrections Batch 
 

 
 

 Click OK 
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Apply the Receipt 

 Load Kea Guester’s records (Hint, right click in Surname field) 

 Select the Receipts Tab 

 Click on  

 <Tab> Select the Corrections Batch 

 Click OK 

 Continue entering the receipt for Kea Guester as per the screen shot below.  
 

 
 
Ensure the receipt is applied against the Voluntary Contributions (VOL01) only. Make sure 
you delete the amounts for School Year Book and Chaplaincy 
 

 
 

 Click on OK 
 

IMPORTANT 

Normally a reversal will be posted into the same open Receipts Batch as 
the original receipt.  However, if the original batch has been closed, you 

need to create a Corrections Batch and this should be selected when 
completing the reversal. 
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25 Refunds 
A refund can be applied when money which has been paid, needs to be returned (refunded) to a 
parent/guardian.  If exporting to RM Finance, a manual written cheque, a system generated 
cheque or an EFT refund can be used.  
 
If not exporting to RM Finance, the user may elect to issue a manual written cheque or alternatively 
a system generated cheque can be created when the expenditure transaction is entered into RM 
Finance. 
 
Refunds can be issued to both Parents/Guardians and Customers, providing their details have 
been entered in RM Finance .  If a they do not exist in the RM Finance datafile, they may be added 
as a Supplier when processing the refund in RM Billing. 
 

Activity: Perform a Student Refund with a System Generated 
Cheque 
 
Jessica Lornab’s mother Averil, has contacted the school to request a refund of the unallocated 
credit of $100 which was the result of the Outdoor Education course reversal.   The school has 
agreed to the refund and a system generated cheque will be used to refund Mrs Lornab. 

RM Billing > Students  

 

 Right Click on Kea Guester and enter Lornab 

 Select the Receipts tab 

 Highlight the Outdoor Education General receipt to be refunded 
 

 
 

 Click   

 Select System Generated Cheque batch 
 

 
 

 Click OK 
 
 

 
 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 246 of 322 

© 2019 Civica Pty Ltd 

 

 

 Enter the Refund Amount of 100 (Note: Full or partial refunds can be entered) 
 

 
 

 <Tab> to the Refunded to:  field and <Tab> again. 
 

 
 

 Mrs Lornab is not in the list of suppliers 

 Click  and enter the following 
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 Click OK 
 

 
 

 Click OK 
 

 
 

 Click OK to select her from the list of suppliers 
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 Enter the Reason for the refund – Refund due to Outdoor Education course being 
discontinued 

 Enter the amount of the 100.00 against Unallocated Credit in the ‘Adjust by’ column 

 Check the total adjustment equals the refund amount 
 

 
 

 Click OK 

 Select the Refunds-System Cheque (J. Lornab)) batch 
 

 
 

 Click OK 
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 View the refund transaction 
 

 
 
 

Note:  Parents and Guardians are entered as suppliers.  They can also be entered via RM 
Finance through Records > Income Source and Suppliers > Add Record. 
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Activity:  Perform a Student Refund via EFT 
 
Sylvestra Sorrell, Jillian’s mother has contacted the school to say Jillian has appendicitis and is 
unable to attend the camp.  As she has paid in full for the camp she has requested a refund 
through EFT to which the school has agreed and will refund back into Mr and Mrs Sorrell’s bank 
account. 
 
RM Billing > Students 
 

 Find Jillian Sorrell  (Hint: Right click on Campbell), type Sorrell and <Enter>) 

 Select the Receipts tab 

 Highlight the Camp receipt to be refunded 
 

 
 

 Click  

 Select the EFT option 
 

 
 

 Click OK 

 Enter the amount of 300 
 

 
 

 Press <Tab> twice 
 
Mrs Sorrell has not been entered as a Supplier in RM finance, so before a refund can be issued, 
she must be added to the Supplier list.  
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 Click  on the Supplier window 

 Enter the following details 
 

 
 

 Click OK to save the new supplier 
 

 
 

 Click OK 
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Sylvestra Sorrell has now been added to the list of suppliers 
 

 
 

 Click OK in the ‘Refund to’ window 

 Enter a reason for the refund <Tab> 

 Enter the School’s name or initials in the EFT Reference field (this will display on the 
recipient’s bank statement) <Tab> 

 

 
 

 Enter the amount for the refund for each billing item in the ‘Adjust by’ column <Tab> 
 

 Select the correct refund billing code for Charges (press <Tab> in the ‘Ref Code’ field)  

 Click OK 
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 Select the Refunds - EFT (J.Sorrell) Batch  

 Click OK 
 

 
 

 View the refund transaction 

 Close the window 
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Activity: Perform a Customer Refund with a Manual Cheque 
 
West Coast Theatre has paid for the Hire of the Hall for weeks 1-5 of Term1. They will not be 
using the hall over this period and have requested a full refund. The school has agreed to this 
refund and will issue a manual cheque with chq number 123568.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                            

RM Billing > Customers  

 Double-click on the West Coast Theatre Customer record 

 Select the Receipts tab 

 Highlight the receipt for 550 to be refunded 
 

 
 

 Click   

 Enter the refund amount of 550 

 Enter the reason for the refund 

 Enter the amount of the refund in the ‘Adjust by’ column 

 Select the correct refund billing code for Facilities Hire (press <Tab> in the ‘Ref Code’ field 
for a list) 

 Enter the manual cheque number 123568 in the ‘Cheque Number’ field 
 

 
 

 Click OK 
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 Select the Refunds – Manual Cheque batch 
 

 
 

 Click OK 
 

 
 

 Close the Customer Details window 
 

Notes:  Customers can only be refunded through manual cheques (if exporting) or system 
generated cheques (if not exporting). 

The Customer Refund screen does not have the facility to enter a name in the ‘Refunded 
To’ section. The refund will automatically be recorded against the customer name which 
cannot change (whereas the fees biller for a student can). 
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25.1  Print the Refund Summary Report 

The Refund Summary Report assists users with reconciling the EFT, System Generated and 
Manual Cheque totals for Refunds.  One or more batches can be be highlighted on the Receipts 
Batches List View screen and the report can be printed and reconciled. 
 

Activity:  Print the Refunds Summary Report 
 
RM Billing > Receipts 
 

 Highlight the Refunds batches 
 

 
 

 Click For Selected > Refund Summary 

 Print the report to the screen 
 

 
 

 View and close the report 
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26 Exporting to RM Finance 
 
All receipts batches (General Banking, EFT, Corrections and Refunds) must be exported as 
required.  All batches must be exported as part of the end of month procedures and before 
reconciling in RM Finance.  Once a batch has been exported, it is automatically closed, so new 
batches would then need to be created in RM Billiing.   
 
On Export, a ‘Receipt Batch Export Summary’ Report will be sent straight to the printer.  This will 
include a list of exported batches, followed by a breakdown of the type of batches exported and a 
total of each batch.   
 
If exporting EFT batches, a system generated Batch number will be produced for the export eg: 
RMB00001EFT. 
 
Before Exporting, RM Finance must be closed. If RM Finance is open, an error message ‘Too 
many records to sort” may be received, which will prevent the export from proceeding.  Once RM 
Finance is closed and the export complete, the user can log back into RM Finance to print the 
Batch Transaction report and  update the batches. 
 

IMPORTANT   

Exporting to RM Finance must not be enabled until permission has been 
granted by the school’s Senior Finance Consultant  
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IMPORTANT  

 Ensure RM Finance is closed before exporting 

26.1 Automatic Export to RM Finance 

The same steps as carried out for manual input need to be carried out for the automatic export. 
The General Banking and Corrections batches must be printed separately, however the refunds 
batches can be selected together for printing the Daily Banking and Receipts Summary.  They can 
also be printed separately if required. 
 

Activity:  Preparing for Automatic Export 
 
Step 1 – Print the Daily Banking and Receipts Summary for the 3 Refunds Batches 
 
The Daily Banking and Receipt Summary for the 3 Refund batches may be printed together or 
they may be printed separately.  Enter them as separate refund batches on the batch register. 
 
RM Billing > Receipts 
 

 Highlight the three Refunds batches 
 

 
 

 Click For Selected > Print Daily Banking 
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 Print a paper copy of the report and file it 

 Fill in the Finance Batch Register using the Daily Banking Report and ensure all the Refund 
batches are separated and identified as shown below on the batch register. 
 

 
 

 Highlight the three Refunds batches 

 Click For Selected > Print Receipts Summary 

 Click Yes to print the Detailed Summary 
 
Three reports for the batches will be generated. Print a paper copy of the reports and file them. 
 
Step 2 – Print the Daily Banking and Receipts Summary for the Corrections Batch 
 
RM Billing > Receipts 
 

 Highlight the Correction Batch 

 Click For Selected < Print Daily Banking 
 

 
 
In this example, the nett effect of the reversal and re-entry is zero, as the total amount reversed 
was Voluntary Contributions and the total amount re-entered was Voluntary Contributions.  
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There has been no movement of funds between billing codes, so no changes will occur in RM 
Finance.  Any reversals and re-entry of receipts, resulting in the movement of funds from one 
billing code to another and the movement from one budget code to another, must be reflected in 
RM Finance. 
 

Note:  Reversals should be entered into the Adjustments/Reversals section in the Income 
(I/C) column.  (Reversals are income corrections transactions).  Refunds should be 
entered into the Expend Payments (ESP) column.  (Refunds are expenditure 
transactions). 

 Print a paper copy of the report and file it 
 

 Highlight the Corrections Batch 

 Click For Selected > Print Receipts Summary 

 Click Yes to print the Detailed Summary 

 Print and file the report 

 Fill in the Batch Register 
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26.2 Export Receipt Batches to RM Finance 

RM Billing > Utilities 

 Double click Export to RM Finance 
 

 
 
 

 
 

 Click YES 

 Highlight ALL the banking Refunds Batches and the Corrections Batch 
 

  
 

Notes:  The Corrections Batch has a Nett effect of $0.00. While this batch is still 
exprorted, it will not appear in RM Finance as there are no transactions to update. 

Batch B00004 has been closed and the receipts entered manually into RM Finance. 
Reversal of subject charges resulting in unallocated credit and the re allocaton to other 
subjects, has resulted in the re allocations within the batch.  We will export this batch 
later when we deal with Re-Allocations. 
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 Click OK 

 Check the settings on the Print Setup screen and click OK (do not cancel at this stage 
otherwise transactions will not be exported) 

 
The export process will begin 
 

 
 
 

 
 

 Click OK 

 Close the Utilities window 
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Note:  The Receipts Batch Export Summary Report detailing the exported batches, must 
be signed and dated by the Principal and filed. 
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26.3  Re-print the Receipts Batch Export Summary Report 

It is possible to re-print the Receipts Batch Export Summary which have been previously sent 
directly to the printer.  The reports are listed in date/time order – decending, with the most recent 
appearing at the top of the list.  The default date displayed is set to 3 months prior to the current 
system date.  The user has the option of re-printing reports after a specific date or printing all 
reports. 
 

Activity:  Re-print Receipts Batch Export Summary 
 
RM Billing > Reports 
 

 Open the Audit Reports folder 

 Highlight Re-print Receipts Batch Export Summary 

 Select the ‘Show reports after’ radio button 

 Highlight the report to be printed 
 

 
 

 Click Print and Ok to print to screen 

 View and Close the report 
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26.4  Check and Update the Transactions in RM Finance 

It is now necessary to update the Expenditure transactions that have been automatically exported 
from RM Billing to RM Finance 
 

Activity: Update Exported Transactions in RM Finance 
 
Update the Expenditure Batches in RM Finance 
 
RM Finance >Transactions 
 

 Select  

 Select the Batched Transactions report 
 

 
 

 Select Expenditure only 

 Select the Cheque Account only 

 Click   
 

 
 

 Check the report against the Receipts Summary 
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RM Finance > Transactions  
 
Update the Expenditure batch for West Coast Theatre/Manual cheque 
 

 Click View/Post Batch 

 Select Expenditure and Credit Notes 

 Enter Batch B00007 
 

 
 

 Click Display  
 

 Click Select All   
 

 
 

 Click  
 

 
 

 Click Yes 

 Click    
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RM Finance > Transactions  
 
Update the Expenditure batch for Jessica Lornab/System Generated Cheque 
 

 Click View/Post Batch 

 Select Expenditure and Credit Notes 

 Enter Batch B00008 
 

 
 

 Click Display   

 Click Select All   
 

 
 

 Click   

 Click Yes 

 Click    
 

 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 268 of 322 

© 2019 Civica Pty Ltd 

 

View the System Cheque 

RM Finance > Transactions  
 

 Click Payments 

 Select Print Payments 
 
The cheque is ready to be printed. 
 

 Click on the  to highlight the line 
 

 
 

 Click Print Payments 

 The cheque number is added prior to printing 
 

 
 

 Click OK 
 

 
 

 Click Yes and Close 
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RM Finance > Transactions  
 
Updating the Expenditure batch for Jillian Sorrell/EFT Refund RMB000001EFT 
 
If your school has elected to use EFT/BPAY processing, the updating of an EFT Batch is a two 
part process. The Principal (or any other delegated cheque signatory) must certify the batch.  
This involves the Principal logging into RM Finance to certify the batch and then logging out.  
The Registrar will then log into RM Finance and Update the batch.  As we are not set up with the 
necessary access user rights, we will be unable to update this batch in training. The same steps 
are carried out until the update screen is displayed. 
 
An EFT batch is updated by the EFT/BPAY Payment Summary option 
 

 Click View/Post Batch 

 Select EFT/BPAY Payment Summary 
 

 

 
 

 Enter the Batch Reference RMB000001EFT 
 

 
 

 Click Display   
 

 
 

 Click  and Close Finance 
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27   RM Billing and Administration Module  

27.1  Moving a Student to the Former Roll 

When a student is moved to the Former Roll their RM Billing Information can still be accessed. 
 

Activity: Moving Students to the Former Roll 
 
John Smother is leaving school today and needs to be moved to the Former Roll.  Move him to 
the Former Roll and then locate his details in RM Billing. 

General > Student Details 

 Use the Search field to locate John Smother   

 Click Move Student to Former Roll   
 

 
 

 Click Yes 

 <Tab> to accept the default date 

 Select a destination and enter a reason for leaving 
 

 
 

 Click OK 
 

 

 Click Remove from all current and future cohorts  

 Yes to save a copy of the teaching sets 
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27.2 Student Name Changes 

Occasionally, student name changes occur.  When this change is made in General > Students, 
users will need to update the records in RM Billing.  This update can be run through the individual 
student screen or by running a utility to update the records of all students with a name change. 
 

Activity: Update a Student Name Change 
 
Brent Murray’s guardians have provided the relevant documentation advising that Brent will now 
be known as Brent Donovan. 

 General > Student Details 

 Load the Records for Brent Murray 

 Click on Edit student   

 Enter Donovan in the Surname and Legal Surname  
 

 
 

 Click OK  

Note: The name change is not currently showing in Student list 

RM Billing > Students 

 

 Find Brent Murray 

 Open Brent Murray’s record 
 
The updated name appears under student details. The ‘Update Student name from Admin’ icon 

 appears on the student record and when clicked will update the student’s record. 
 

 Click on the    icon to update Brent Donovan’ s record 

 Note that the name details have updated 
 

 
 

 Click Return to View  
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Activity: View records of Former Roll Students 

RM Billing > Students 

 
Once a student has been moved to the Former Roll, their records are still available in RM Billing. 
Open the records for John Smother. 
 

 Click on   

 Select the Former Roll   from the drop down list 
 

 
 

 Type Smother into the Surname/Ref field  and click   

 Double Click on his name to open his records 

 Click on the Billing Items tab 
 

 

  
 
John still has an outstanding balance on all his billing items 
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 Return to View   

 Highlight his name 

 Click For Selected > Print Statement 

 Type today’s date 

 Follow the printer prompts 
 
Although John has left the school, it is still possible to print and send a statement 
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27.2.1 RM Billing > Utilities > Update Student Details from Admin 

There is also the option to use the name update utility which will update the records for all students 
with name changes. 
 

 Click on Update Student Details from Admin, the following message will appear. 
 

 
 

 To update RM Billing with any student name changes from the Administration module, click  
Yes. 
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28 Write-offs 
 
It will be necessary to write off irrecoverable charges from students on the Current and Former Roll 
and sometimes it may be necessary to write off customer debt.  It is important that reports created 
using this process are kept on file for use at a later date.  Write-offs can be performed whenever 
charges are deemed as irrecoverable from current and former roll students and customers. 
 
Refer to the Department of Education’s Write-Off Procedures for Irrecoverable Debts document for 
further information regarding all write-offs. 
 
At the beginning of a year schools should look back at their previous year’s billing data. Any 
amounts which are deemed as irrecoverable can be written off. Write-offs from previous years can 
also take place throughout the year however they should only be submitted to DoE once a year.  
Schools should maintain a write-off file throughout the year which contains: 
 

 a copy of all write-off applications (including provisionally approved applications), lists and 
supporting documents; 

 a copy of all approvals from the Corporate Business Services to write-off debts; and 

 all other relevant supporting documents. 
 
In accordance with Treasurer’s Instruction 107 Authorisations, the Director General has authorised 
school principals to provisionally write-off irrecoverable debts with a value of up to $5 000 per 
student. These write-offs have to be periodically submitted to the Director General for the final 
approval.  For further information refer to the Department’s documentation. 
 
Unpaid voluntary amounts will need to be removed from current and former roll students.  These 
amounts can be cancelled.   They do not have to be reported to the Department of Education. 
 
Refer to the Department of Education policies for more information.   
 

IMPORTANT:  Ensure a copy of all write-off applications, supporting 
documents, reports and approvals are filed.  

 
A copy of the write-off application form is shown on the following page. 
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RM Billing Sec Training Notes 2019 5-Feb-19   

Page 277 of 322 

© 2019 Civica Pty Ltd 

 

28.1 Writing Off Debt from Students and Customers 

 
As part of the end of month process and at the end of each year, it is necessary to review students 
on the current and former rolls and write off irrecoverable charges and cancel uncollected voluntary 
contributions. If Customer debt is to be written off, then the same procedure are carried out as with 
students. 
 
When writing off billing items from students, the user will access Write off/Cancel Student Related 
Debt via the Utilities menu. 
 
When writing off billing items for Customers, the user will access Write off/Cancel Customer 
Related Debt via the Utilities menu. 
 

28.1.1 Creating Billing Item Batches to hold written-off or cancelled amounts  

Activity: Create a Billing Items Batch for items Write Off/Cancel 
Students Debt 
 
Create a Billing Item batch for these write off/cancelled items to be processed into.  These 
batches will only need to be created when required for write-off purposes 

RM Billing > Billing Items 

 Click Add Item  

 Enter the description as Write-off/Cancel student related debt <$5000 per student 

 Click OK 
 

 
 

 Click Return to View   
 

Note:.  Billing Item Batches can be duplicated from the Billing Items list by selecting the 
batch to be duplicated and choosing For Selected > Duplicate Batch. 
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Activity: Create a Billing Items Batch for items Written Off -
Customers 
 
Repeat to create a Billing Item batch for West Coast Theatre who have gone into receivership. 
 

RM Billing > Billing Items 

 Click Add Item  

 Enter the description as Write-off/Cancel customer related debt <$5,000 per customer 
 

 
 

 Click OK 
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28.1.2 Writing off Debt from Students 

When charges or contributions are deemed as unrecoverable from students they can be written off 
or cancelled.   
 

Activity: Write off Debt from Students 
 
Charges and contributions have been deemed as unrecoverable from Kate Osterburg, Kelly 
Anne Mojo, Lauren Marston and John Smother. Produce a write-off report for the Principal to 
sign.  Write off debt for these students.  As John Smother is now on the former roll, he will be 
dealt with after the current roll students. 

RM Billing > Utilities 

 Double click Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 

 Select 2019 as the Year 
 

 
 

 Click Student Find   

 Select Year Group 11 > Find 

 Highlight, Lauren Marston, Kelly Anne Mojo and Kate Osterburg 

 Click Select and Yes 

 Click OK 
 

 Highlight the students and select debt to Writeoff/Cancel  
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 Click Print Selected   

Note: This report must be printed, signed by the Principal and filed in the write-off file. 

 
 
 
 

 
 

Note: Clicking    will print a list of all students viewed in the Write off/Cancel Debt 
screen.  This report should not be used to record the Principal’s authorisation for write 
off. 

 Close the report 
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 Click For Selected > Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 
 

 
 

 Click Yes 
 

 <Tab> in the Batch field and select the Write-off/Cancel Student Related Debt <$5000 per 
student batch 

 Enter the reason for the write off as Provisional Approval dd/mm/yy 
 

 
 

 Click OK 
 

 
 

 Click OK 

 Close the Write off/Cancel Student Related Debt window 
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John Smother has left the school and it has been deemed that his Charges and Contributions 
will not be recovered, so this debt will be written off. 
 

RM Billing > Utilities 

 Double click Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 

 Select 2019 from the drop down menu 
 

 

 Click Student Find    

 Change the Roll Status to Former   
 

 Type Smother into the Surname/Ref. No   and click  
 

 
 

 Click OK 

 Highlight John Smother’s record 

 Select to Writeoff/Cancel debt related to Charges, Vols and Other Optional Costs 
 

 
 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 283 of 322 

© 2019 Civica Pty Ltd 

 

 Click Print Selected    

Note: This report must be printed, signed by the Principal and filed in the write-off file. 

 

 View and close the report 

 Click For Selected > Write off/Cancel Student Related Debt 
 

 
 

 Click Yes 
 

 
 

 Click Yes 

 <Tab> in the Batch and select the Write-off batch 

 Enter the reason for the write off as ‘Provisional  approval dd/mm/yy’ 
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Click OK 
 

 
 
Click OK 
Close the Write-off/Cancel Student Related Debt window 
Close Utilities 
 

Note: All debt for the selected year will be cleared against the nominated student 

 
 

 
 

IMPORTANT: 

 Use the write-off report from RM Billing and follow the write-off 
procedures to submit the School Debt Write Off Application Form 
($5,000 or less) to Corporate Business Services for final write off 

approval from the Director General.  Voluntary amounts are cancelled, 
not written off, therefore must not be included in the application. 
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Activity: View Written Off/Cancelled Billing Items in Students 
Records 

RM Billing > Students 

 Open the record for Kate Osterburg 

 Select the Billing Items Tab 

 Click on the Reason header 

 View the written off and cancelled debt 
 

 
 

 Click on  
 

 
 
 

 View the screen and Close  
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28.1.3 Writing off Debt from Customers 

When charges are deemed as irrecoverable from customers they can be written off. 
 

Activity: Write off Debt from Customers 
 
West Coast Theatre has gone into receivership and charges have been deemed as 
irrecoverable.  Approval for write-off has been received by the Principal.  Write off debt for this 
customer. 

RM Billing > Utilities 

 

 Double click Write off/Cancel Customer Debt 
 

 
 

 Click Yes 

 Select 2019 from the drop down menu 

 Click Customer Find  

 Select West Coast Theatre 
 

 
 

 Select the line for the Hall Hire for $495 

 Click OK 
 

 
 

 Click Yes 

 <Tab> in the Batch and select the Write-off/Cancel customer related debt<$5,000 

 Enter the reason for the write off as Provisional  Approval dd/mm/yyyy 
 

 



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 287 of 322 

© 2019 Civica Pty Ltd 

 

 

 
 

 Click OK 
 

 
 

 Click OK 

 Close the Write off Customer Debt window 
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28.1.4 Printing the Transaction Summary for Customer Write-offs 

A write-off report must be printed and signed by the Principal for all Customer write-offs.  This 
report must then be filed. 
 

Activity: Print the Write-off Report for Customers 
 
Print the transactions summary report for West Coast Theatre for the Principal to sign and to be 
filed. 
 

RM Billing > Reports >Transactional Reports 

 Select the Transaction Summary 

 Select Billing Items 

 Click Customer Find  

 Select West Coast Theatre 

 Enter the relevant date range or delete the dates 

 Select the Other tab 

 Enter the Reason containing as Writeoff (No spaces) 
 

 
 

 Click Print 
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IMPORTANT:    Use the write-off report from RM Billing and follow the 
write-off procedures to submit the School Debt Write Off Application 

Form ($5,000 or less) to Corporate Business Services for final write off 
approval from the Director General.    
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28.1.5 Closing the Write-off Batches 

The write-off batches must be closed and a new batch will need to be created for the next write-
off/cancellation. 
 

Activity: Closing the Write-off Batch for Students 
 
As the write-off has now been completed and the School Debt Write-off Application Form 
($5,000 or less), submitted it off the write-off batches for students and customers can be closed. 

RM Billing > Billing Items 

 Ensure 2019 is selected from the drop down menu 

 Highlight the two Writeoff batches 
 

 
 

 Click For Selected > Close Batch 
 

 
 

 Click Yes 
 

IMPORTANT: 

When writing off student and/or customer debt for more than $5,000 
approval must be received from the Director General prior to completing 
the process.  Once the write-off report has been printed and signed by 
the Principal, the School Debt Application Form (over $5,000) must be 
submitted.  When approval is received the write-off process can be 
completed. 
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29 Unallocated Credit 
As part of the End of Month Process, the Unallocated Credit Listing Report should be viewed in 
order to identify students and customers with unallocated credit. Users should endeavour to clear 
unallocated credit where ever possible 
 

29.1 Allocate Unallocated Credit via the Student Record 

Activity: Review Unallocated Credit 
 
Rhys Fitton has unallocated credit due to an overpayment made earlier.  We have been advised 
that the payment relates to the Year 11 Camp which Rhys will be attending. Some students have 
credit related to the Outdoor Education course being discontinued. 

RM Billing > Reports > Financial Reports 

 Select the Unallocated Credit Listing Report 

 Select to view Students 

 Print and OK 
 

 
 

 View and Close 
 

 
 
Add the Billing Items and Apply the Unallocated Credit 

RM Billing > Students 

 Open the record for Rhys Fitton 

 Click on the Billing Items tab 
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 Click on  

 Select to Add to Billing Item Batch and click OK 
 

 
 
 

 
 

 Click OK to 2019 

 Select the Year 11 Camp  
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 Click OK 

 Highlight the three 2019 Camp billing items 
 

 
 

 Click on Allocate   

 Allocate the 300 against the Camp billing items 
 

 
 

 Click OK 
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29.2 Auto Allocate Unallocated Credit 

The other students’ Unallocated Credit is a result of reversal of a discontinued Subject that had 
been paid for. If the credit is GV, it must be be allocated to Billing Items in the order described in 
the Table in Section 8.2.1 of these Training Notes. 
 

Activity: Allocate Unallocated Credit to Subject Costs 

Michael Fulter has unpaid Billing Items and $100 credit due to the discontinued Outdoor 
Education subject. We will allocate his credit to his Camp Billing Items (parental permission must 
be given). 

 
David Maroney has GV credit due to the discontinued Outdoor Education subject. This can also 
be allocated to other unpaid charges. 

RM Billing > Billing Items 

 Double click on the Year 11 Camp Batch 

 Click on the Batch Billing Items Tab 

 To remove any Reversals and Adjustments click on  

 Click on the filter button  

 Enter Balance > 0.00  
 

 
 

 Click OK 
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All items with a balance to pay will be highlighted. 

 

 

 Click Auto-Allocate  
 

 
 

 Click Yes to the message 
 

 
 

 Click OK  
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Note: This process should be repeated for other Billing Items until all the credit for all 
students is allocated. 

 
 

 Click Yes to the Report Printed OK 
 
The Auto-Allocation Report will be sent straight to the printer 
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This Report can be re-printed if required from Reports > Transactional Reports > Re-Print  
Auto Allocate Transactions 
 

 
 
 

 

Warning:  The previous activity demonstrates a simple application of 
unallocated credit.  Schools must apply unallocated credit in 

accordance with the receipting business rules.  Parental permission 
must also be received to reallocate any unallocated credit.  This 

process should be undertaken with care.  For more information, log on 
to http://det.wa.edu.au/finance/detcms/portal/ to access the document  ‘Auto 

Allocate Unallocated Credit.’ 

 
  

http://det.wa.edu.au/finance/detcms/portal
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29.3 Unallocated Credit Listing 

 

Activity: 

RM Billing > Reports 

 Open the Financial Reports Folder 

 Highlight the Unallocated Credit Listing 
 

 
 

 Click Print and OK to the screen 
 

 
 
There should be no items to print as we have allocated all the credit. 
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30 Exporting Re-allocations to RM Finance 
 
Movement of payments from one billing code to another where the billing codes are different and 
are posted to different Analysis and Budget codes, will result in a re-allocation transaction.  These 
changes must be reflected in RM Finance.  The Export to RM Finance Utilitiy will process these re-
allocations automatically in the original batch in which the transactions were processed .  This 
batch is marked with an Asterisk. 
 

Activity: Export Re-allocations to RM Finance 
 
RM Billing > Utilities 
 

 Double click Export to RM Finance 

Note:  Ensure RM Finance is closed before you export 

 
 

 Click Yes 

 Highlight the General Banking batch 
 

 
 

 Click OK 

 Click OK to Export Complete 
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The Receipt Batch Export Summary is sent directly to the printer 
 
 
 

  
 
 
 
 
 
The Report must be signed and dated by the Principal and filed with the End of Month reports 
 

 

Important: Allocating GV Credit will not result in Re-Allocations as 
Government Subsidy Receipts are not entered into RM Finance 
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30.1  Updating the Automatically Exported Transaction  

Activity: Update the Export Transaction 
 
Open RM Finance 
 

 Log in as Manager Corporate Services and Password Keys 
 

 
 
Check the Batched Transaction Report 
 
 
RM Finance > Transactions 
 

 Select  

 Select the Batched Transaction Report 

 Select Income only 

 Select the Cheque Account only 

 Click Print 
 

Update the Income Batch in RM Finance 
 
Transactions > View/Post Batch 
 

 Select Income 

 Enter Batch Ref B00004 
 

 
  

 Click Display  

 Click Select All  
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 Click Update  

 Click Yes 

 Close RM Finance 
 
 
 

 

Note:  If not exporting to RM Finance, then the Re-allocations must be entered manually as 
outlined in Section 31 .  
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31  Re-allocations for Non Exporting Schools – Discussion Only 
 
At times the allocation of receipts may change in RM Billing. For example, Rhys Fitton’s parents 
have paid some money in advance to be used throughout the year. The money is entered in RM 
Billing as unallocated credit. It is then transferred into RM Finance and posted against the 
suspense account (N3199). 
 
The student is then billed for a camp and the parent instructs for some of the money to be used. 
The money is now allocated in RM Billing to the Camp billing items for the student.  
 
The result is that the allocations in RM Billing have changed, and therefore a change needs to be 
made in RM Finance to ‘move’ the money out of the suspense account and into the appropriate ‘C’ 
account for the camp. 
 
The ‘Print Re-allocation Transactions’ function produces a Receipts Summary report which lists 
these types of changes only, so that the necessary adjustments can be made in RM Finance. 

Note: The end of month procedures for non exporting schools, require re-allocation 
transactions to be entered into RM Finance and marked as posted in RM Billing.   

The following steps outline the processes required if schools are NOT exporting to RM Finance.  
 
Step 1: Print the re-allocation transactions report 

RM Billing > Reports 

 Open the Transactional Reports folder 

 Highlight Print Re-allocation Transactions 
 

 
 

 Click Print and OK to print the report to the Printer 
 
The Detailed Receipts Summary is printed along with the Totals Only Report 
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 Select Yes 
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 Click on OK 
 
The Reallocations should be entered into RM Finance. Re-Allocations will display as Income 
Correction Transactions as well as Income Transactions.   
 
Sample of Transactions 
 
This below example would be the reallocation of Rhys Fitton’s $300 unallocated credit being 
applied to the Camp Billing Items.  Any other reallocations would also be entered. 
 

Budget Account Budget 
Code 

Amount Tax Code Transaction 

Unallocated Credit N3199 -300 8 Income 
Correction 

Camp C1181 150 0 Income 
 

Camp C1181 150 1 Income 
 

 

Note:  The total of all the reallocations on the report should total to zero.  Ensure that the 
correct GST code is used when processing reallocation transactions. 

Reprint Reallocation Reports 

It is possible to reprint Reallocation reports which have been previously printed and posted. 

RM Billing > Reports >Transactional Reports > Reprint Reallocation Transactions 

A list of previously printed and posted reallocation reports will appear.  Click on the report to be 
reprinted.  Click on Print to reprint the report. 
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31.1 Enter Re-allocation Transactions into RM Finance 

Step 2. Enter the re-allocation Transacactions into RM Finance 
 
Processing Reallocation Transactions into RM Finance is a two part process in which transactions 
are moved from a budget account via an Income Adjust Transaction and re entered into the 
required account via an Income Transaction. 
 

 Complete the Income Adjustment Transactions Form 
 

 
 

 Complete the Batch register 
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Step 3. Enter the Income Correction into RM Finance 

 Open RM Finance 

RM Finance >Transactions > Adjustments and Corrections.   

The following Adjust/Correct transaction will move the 300.00 out from the N3199 Suspense 
Account. 
 

 Select Income > Adjust/Correct  

 Enter Inc Source INC001 

 Enter total amount of 300.00 

 <Tab> past today’s date 

 Enter reference IT1 

 Enter Batch Reference 20 

 Enter detail - Billing Reallocation Report  dd/mm/yy 

 Enter Nett amount  

 Tax code 8 

 Budget code N3199 
 

 
 

 Click OK 

 Select the Cheque Account and OK 

 Yes to batch 
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Step 4. Review the Batched Transaction Report 

 Click on  

 Click on  
 

 Select to view Batched Transactions 

 Select Transaction type Income 
 
 

 
 

 Click on Print 
 

 
 

 View the Batched Transaction report and close. 
 
 
 
 
  



 
RM Billing Sec Training Notes 2019 5-Feb-19   

Page 309 of 322 

© 2019 Civica Pty Ltd 

 

Step 5. Update the Batch 

RM Finance >Transactions  

 Click  View/Post Batch 

 Click on Income 

 Enter the Batch Reference  
 

 
 
 

 Click on Display 
 

 Click to change the No to Yes 
 

 
 

 Click on,   
 

 
 
 

  Click Yes to post the batch 
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Step 6. Entering the Income Batch 

RM Finance > Transactions 

The following Income transaction will process the 300.00 into the C1182  account for the Camp. 

 Select Income 

 Enter the income transaction as shown below: 
 

 
 

 <Tab> the first line down into All Income Lines 

 Continue to enter the second transaction line 
 

Billing Reallocation Report dd/mm/yy C1182 $150 1 

 

 
 

 <Tab> the second line into All Income Lines 

 Click on OK 

 Select the Cheque Account and OK 

 Yes to batch the transaction 

Review the Batched Transaction Report 

 Click on  

 Select to view Batched Transactions 

 Select Transaction type Income 

 Click on Print 
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 View Report and Close 
 

Step 7. Update the Batch 

RM Finance >Transactions  

 Click  View/Post Batch 

 Click on Income 

 Enter the Batch Reference  

 Click  Display 
 

 
 

 Click on ,  and Yes to post the batch 
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32 End of Month Procedures and Reporting 
Whilst RM Billing does not have a month end roll over function, certain tasks need to be performed 
in RM Billing at the end of each month. This will ensure that RM Billing and RM Finance are co-
ordinated and also that any items which may need attention in RM Billing are handled in a timely 
fashion.  

32.1 Month End Checklist 

The following check list should be used for RM Billing at the end of each month. (Refer to the RM 
Finance Registrar’s End of Month Check List (for RM Billing Schools) provided by the Department 
of Education for further detail.) 
 

Task Necessary Steps 

Review students on the 
former roll 

 Process refunds or transfer transactions if required. 
 

 Process write-offs for irrecoverable debt according to 
department policy. 

 

Review students on the 
current roll 

 Process refunds if required. 
 

 Process write-offs for irrecoverable debt according to 
department policy. 

 

Check and clear 
unallocated credits in RM 
Billing 

 Print the Unallocated Credit Listing (Reports > Financial Reports 
> Unallocated Credit Listing for both Students and Customers). 

 

 Investigate each occurrence and allocate or refund credit 
amounts.  Where applicable. 

 

Ensure all transactions 
are transferred to RM 
Finance 

 If not exporting to RM Finance, ensure all receipts batches in 
RM Billing have been balanced with the banking, reports printed 
and batches closed. Ensure all receipts batches in RM Billing for 
the current period have been posted into RM Finance. 

 

 Print any re-allocation transactions (Reports > Transactional 
Reports) and ensure they are posted into RM Finance. 

 
OR 

 

 If exporting to RM Finance, export the Corrections batch to RM 
Finance and any other open receipts batches (RM Billing > 
Utilities > Export to RM Finance).  Where applicable 

 

 Follow the procedures listed in these notes regarding filling in 
the batch register and which reports to print. The Receipts Batch 
Export Summary is printed automatically on export.  

 

 Print the Receipt Batch Export Summary showing there are no 
batches to export 
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Review the Billing 
Suspense Account 
(N3199) in RM Finance.  
This holds the 
unallocated credit 
amounts. 

 If the balance is not zero, check the report and view the 
transactions to determine if correct. Make corrections if 
necessary. 

 

 The total in the Billing Suspense account should equal the 
amount of unallocated credit reported on the Unallocated Credit 
Listing in RM Billing – unless there are any unexported batches 
for the next month or unallocated Government Subsidy (eg 
payment type GV). 

 

Check all batches are 
updated in RM Finance 

 RM Finance > Reports > Batched Transactions.  Check for 
Income and Expenditure to the relevant bank accounts.  If a 
report is produced investigate the reason why these batches are 
yet to be updated in RM Finance.  Update the batches. 

 

Check the balance of 
N3505 in RM Finance is 
zero 

 A balance in this account indicates a GST posting error in RM 
Finance. 

Perform the reconciliation 
of all bank accounts in 
RM Finance 

 Clear 0.00 transactions by reconciling them. 
 

 The RM Billing portion of the bank deposit should be reconciled 
with the Daily Banking Summary and the Batch Register. 

 

 The RM Billing Batch Number should be noted against the 
relevant deposit on the bank statement. 

 

Check for negatives on 
the BAS as a result of 
Adjustments 

 If any negatives exist seek help from your SFC. 

Print the following RM 
Billing Reports 
(mandatory) 

 Audit Report (Reports > Audit Reports > Audit Report.) Save 
this report as <Month yyyy> to disk (G:\RM Billing Audit Log 
<yyyy>). 

 

 Receipt Batch Export Summary- if exporting.  This report is 
only printed automatically on export it is to be signed by the 
Principal on each export.  If any batches remain unexported 
these should be noted on the report with a reason why they have 
not been exported 

 

 Transaction Summary Report for the current month for 
correction items - Principal to sign (Reports > Transactional 
Reports > Transaction Summary). See screen shot below – date 
range should be for the month being reported) 
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Transaction Summary Report for discounted items. 
 Principal to sign (Reports > Transactional Reports > Transactions  
Summary > Billing Options tab > tick show discounted billing items 
 only.  
 

 
 

 
 

Print the following RM 
Billing Reports (optional) 

 Summary Aged Debt List (Optional Report) when required, 
for debt management.  (Reports > Financial Reports > Summary 
Aged Debt List – Students and/or Customers) 

 

Note: Further questions on month end procedures can be directed to your SFC. 
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33 Support (Transactional) 
 
Should you need any transactional support please contact Financial Operational Support at 
Business and Customer Services (BCS) 
 
Contact details below: 

33.1 Email (BCS) 

Financialservices.support@education.wa.edu.au  
 

34 Support (Systems) 
 
Should you need any systems support, please contact the Customer Service Centre (CSC) at the 
Department of Education 
 
Contact details below: 
 

Phone (CSC) 

Metro:  9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem 
 

FAX (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem 
 
 

Email (CSC) 

customer.service.centre@det.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem 
  

mailto:Financialservices.support@education.wa.edu.au
mailto:customer.service.centre@det.wa.edu.au
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35 Online Manuals and Training Notes 

35.1 Civica Education 

Online manuals and training notes are available to download in PDF format from the Civica 
Education website. 
 
http://www.civicaeducation.com.au/ 
 
Select Integris Support. 
Log in to Western Australian SIS Schools. 
Username: school 
Password: help 
 

35.2 STIMS Project 

The Department’s Student Information Management Project (STIMS) website has numerous 
factsheets and support documents for all SIS Administration modules. 
 
http://www.det.wa.edu.au/intranet/stims  
 
Links to the Integris Manuals are also available from the STIMS website or by going to Help within 
Integris. 
  

http://www.civicaeducation.com.au/
http://www.det.wa.edu.au/intranet/stims
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36  Finance Web 

36.1 http://det.wa.edu.au/finance/detcms/portal/ 

Log on to the DET Portal to access the latest factsheets  
 
Go to Financial Systems and RM Billing 
 
  

http://det.wa.edu.au/finance/detcms/portal/
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     For the month of                                                                            Period      
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Adjustments/Reversals ** 
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Charge** 

Accruals 
(Manual 

Only) 

BA/Vire 
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Type of  
Batch* 
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[E] EFT 
[B] BPay 
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*Reversals and internal charges are not batched but must be recorded.  RM Billing batches are prefaced with a ‘B’.  Accruals are entered if manually processed. 
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